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Please carefully read the Operating Instructions before operating. Keep this CD-ROM in the protective case.
Do not expose the CD-ROM to direct sunlight or extreme heat and do not scratch or smudge the surface of the
CD-ROM.
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Thank you for purchasing the Panasonic KX-P8410 Color Laser Printer.
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The serial number is located on the label on the rear of the unit. For your convenience, record the

number below and keep this book along with your proof of purchase, in the event of a theft or for future
reference.

MODEL NO. KX-P8410 SERIAL NO.

NAME OF RESELLER DATE OF PURCHASE

guidelines for energy efficiency.

/‘\ As an Energy Star Partner, Panasonic has determined that this product meets the Energy Star
W (The international Energy Stars" Logo is valid in U.S.A., Europe and Japan only.)

The operating instructions are subject to change without notice.
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End-User License Agreement

THIS IS A LEGAL AGREEMENT BETWEEN YOU AND PANASONIC. CAREFULLY READ ALL THE TERMS
AND CONDITIONS OF THIS AGREEMENT PRIOR TO OPENING THE PACKET OF SOFTWARE
PROGRAM. OPENING THE PACKET INDICATES YOUR ACCEPTANCE OF THESE TERMS AND
CONDITIONS. If you do not agree to these terms and conditions, return the unopened packet and the other
components of the Panasonic product to the place of purchase and your money will be refunded. No refunds
will be given for the products that have an opened packet or missing components.

1. COPYRIGHT:
Panasonic has the right to license or has been granted to license the enclosed Software Program
(“SOFTWARE"), developed and copyrighted by Kyushu Matsushita Electric Co., Ltd. or its licensor
(“Licensor”). You acknowledge that you are receiving only a LIMITED LICENSE TO USE the SOFTWARE
and related documentation, and that you shall obtain no title, ownership nor any other rights in or to the
SOFTWARE and related documentation, all of which title and rights shall remain with Licensor and
Panasonic.

2. LICENSE:

(1) You have the non-exclusive rights to use the SOFTWARE on your computer. (2) If you wish to use the
SOFTWARE in your network, you may install the SOFTWARE into a network server and/or its clients and
use the copies of SOFTWARE in your network. (3) You may make reasonable quantities of copies of the
SOFTWARE solely for backup or archival purposes. (4) You may not rent or lease the SOFTWARE, but you
may transfer your right under this License Agreement on a permanent basis, provided that you transfer this
Agreement, all copies of the SOFTWARE, all related documentation and your Panasonic product, and the
recipient thereof agrees to the terms of this Agreement. (5) You may not reverse engineer, decompile or
disassemble the SOFTWARE, except that in European Union and European Free Trade Association, you
may have the limited right to reverse engineer, decompile or disassemble the SOFTWARE solely to the
extent specifically permitted by the terms and conditions of Article 6 of the European Community’s Directive
for the Legal Protection of Computer Programs, OJL 122/42 (17 May 1991). (6) You may not use, copy,
modify, alter or transfer the SOFTWARE, any copy thereof or its related documentation, in whole or in part,
except as expressly provided in this Agreement.

3. TERM:
This license is effective until terminated. You may terminate this Agreement at any time by destroying the
SOFTWARE and related documentation and all copies thereof. This license will also terminate if you fail to
comply with any term or condition of this Agreement. Upon such termination, you agree to destroy all copies
of the SOFTWARE and related documentation.

4. LIMITED WARRANTY:
Within ninety (90) days of your receipt of the SOFTWARE, Panasonic warrants that the storage media on
which the SOFTWARE are furnished is free from defect in materials and workmanship under normal use,
and that it will repair or at its option replace any defective media at no charge to you, provided that such
defective media is returned to Panasonic within such ninety (90) days period.

5. LIMITATION OF LIABILITY:

EXCEPT AS STATED ABOVE, NEITHER PANASONIC NOR PANASONIC'S SUPPLIER MAKES OR
PASSES ON TO YOU OR OTHER THIRD PARTY, ANY WARRANTY OR REPRESENTATION
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. WITHOUT LIMITING THE GENERALITY OF THE FOREGOING,
NEITHER PANASONIC NOR PANASONIC’S SUPPLIER WARRANTS THAT THE SOFTWARE WILL BE
ERROR-FREE OR THAT IT WILL MEET YOUR REQUIREMENTS. NEITHER PANASONIC NOR
PANASONIC’S SUPPLIER SHALL BE LIABLE FOR ANY DAMAGE SUFFERED BY YOU INCLUDING,
BUT NOT LIMITED TO, CONSEQUENTIAL, INCIDENTAL SPECIAL OR PUNITIVE DAMAGES. THE
ABOVE LIMITATIONS SHALL APPLY REGARDLESS OF THE FORM OF ACTION WHETHER IN
CONTRACT, TORT (INCLUDING NEGLIGENCE), STRICT PRODUCT LIABILITY OR OTHERWISE,
EVEN IF SUCH PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.



FOR USERS IN UNITED STATES

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications.

However, there is no guarantee that interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment off and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

® Reorient or relocate the receiving antenna.

® Increase the separation between the equipment and receiver.

® Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
® Consult the dealer or an experienced radio/TV technician for help.

The user may find the booklet “Something About Interference” available from FCC local regional offices
helpful.

FCC Warning: To assure continued FCC emission limit compliance, the user must use the
recommended shielded interfacing cable when connecting to a host computer. Also, any unauthorized
changes or modifications to this equipment would void the user’s authority to operate this device.

Technical Support Calls

If you have read this manual and tried the troubleshooting procedures and you are still having difficulty,
please contact the reseller from which the unit was purchased. You may also call the end user technical
support telephone number which is operational during East Coast business hours (9:00 AM to 7:00 PM).
The end user technical support number is 1-888-744-2424.

This number is available within the U.S. only.

Helpful Phone Numbers

To locate your nearest sales dealer CALL 1-800-742-8086 ask for COLOR
To order consumables CALL 1-800-222-0584
To order operating instructions/CD’s CALL 1-800-833-9626
To locate your nearest authorized service center CALL 1-888-744-2424
For technical support CALL 1-888-744-2424
Automated 24-hour support via Fax back CALL 1-800-222-0584
Electronic bulletin board CALL 1-201-863-7845

World Wide Web Technical & Driver Support http://www.panasonic.com/alive
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For Your Safety

General

~
J

Warning

® To prevent fire or shock hazard, do not expose this product to rain or any type of moisture.

-
.

~
J

Caution

® Do not open covers and do not attempt to repair the unit yourself. Refer servicing to qualified
personnel.

-
.

Power Source

~
J

Warning

® The power source voltage of this unit is listed on the nameplate. Only plug the unit into an outlet
with the proper voltage.

® \When you operate this equipment, the outlet should be near the equipment and accessible.

® To ensure safe operation the AC cord supplied must be inserted into standard three-prong AC
outlet which is effectively grounded (earthed) through the normal wiring.

® The fact that the equipment operates satisfactorily does not imply that the power point is grounded
(earthed) and that the installation is completely safe. For your safety, if in any doubt about the
effective grounding (earthing) of the power point, consult a qualified electrician.

e |f the plug cannot be inserted into the AC outlet, contact a licensed electrician to replace the outlet
with a properly grounded (earthed) one. Do not defeat the purpose of the grounding (earthing) plug
(ex. do not use a conversion plug).

-
.

Laser Safety

Caution

® This printer utilizes a laser.
Use of controls or adjustments or performance of procedures other than those specified herein
may result in hazardous radiation exposure.

Ozone Release

Warning

® Make sure that the printer is installed in a well ventilated room so as not to increase density of
ozone in the air. Since ozone is heavier than air, it is recommended that air at floor level be
ventilated.




For Your Safety

Moving the Unit

The printer weighs approximately 47.9 kg {105.5 Ibs.}. It must be handled by two people. Turn the power off and
remove the power cord when handling the unit.




For Your Safety

Caution Labels

DANGER:

CAUTION:

VORSICHT: ATTENTION:

Invisible laser radiation
when open and interlock
defeated.

AVOID DIRECT

Invisible laser radiation
when open and
interlocks defeated.
AVOID EXPOSURE

Unsichtbare Laserstrahlung,
wenn Abdeckung gedffnet
und Sicherheitsverriegelung
Uberbriickt.

Rayonnement laser invisible
dangereux en cas
d'ouverture et lorsque

la sécurité est neutralisée.

EXPOSURE TO BEAM.

TO BEAM.

NICHT DEM STRAHL
AUSSETZEN.

EXPOSITION DANGEREUSE
AU FAISCEAU.

PELIGRO:

Cuando se abre y se
invalida el bloqueo, se
producen radiaciones
invisibles de laser.
EVITESE LA
EXPOSICION

VARNING:

Osynlig laser-
stralning nar denna
del ar 6ppnad och
sparrar ar
urkopplade.
STRALEN

VARO!:
Néakyméatonta
avattaessa ja
suojalukitus
ohitettaessa olet
alttiina laserséteilylle.
ALA KATSO

VARNING:

Osynlig laserstralning
nar denna del &r
Oppnad och spérren ar
urkopplad.
BETRAKTAEJ
STRALEN.

ADVARSEL:

Usynlig laserstraling
ved &bning nar
sikkerhedsafbrydere
er ude af funktion.
UNDGA
UDSATTELSE FOR

ADVARSEL:

Usynlig laserstraling
nar deksel dpnes og
sikkerhedslas brytes.
UNNGA
EKSPONERING
FOR STRALEN.

A TALES RAYOS. AR FARLIG. SATEESEEN. STRALING.

(220-240 VAC equipment)

CLASS 1 LASER PRODUCT
KLASSE 1 LASER PRODUKT

CLASSE 1 LASER PRODUIT
CLASE 1LASER PRODUCTO

Laser diode properties

Laser output : 5 mW max
Wavelength : 780 nm
Emission duration : Continuous

& CAUTION:
HOT SURFACE INSIDE

CAUTION:
HOT SURFACE
INSIDE

ATTENTION:
SURFACE
CHAUDE
CI-INTERIEUR
VORSICHT:
HEISSE FLACHE
INTERN
ATENCION:
SUPERFICIE
CALIENTE

EN EL INTERNO

CAUTION:HOT SURFACE BELOW
ATTENTION:SURFACE CHAUDE CI-DESSOUS
VORSICHT:HEIRE OBERFLACHE DARUNTER
ATENCION:SUPERFICIE CALIENTE ABAJO

>




For Your Safety
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FOR USERS IN U.K.
IMPORTANT:
FOR YOUR SAFETY PLEASE READ THE FOLLOWING TEXT CAREFULLY
This printer is supplied with a moulded three pin mains plug each for your safety and convenience. A 13
amp fuse is fitted in this plug. Should the fuse need to be replaced please ensure that the replacement
fuse has a rating of 13 amps and that it is approved by ASTA or BSI to BS 1362.
Check for the ASTA mark or the BSI mark @ on the body of the fuse.
If the plug contains a removable fuse cover you must ensure that it is refitted when the fuse is replaced.
If you lose the fuse cover the plug must not be used until a replacement cover is obtained.
A replacement fuse cover can be purchased from your local Panasonic Dealer.
IF THE FITTED MOULDED PLUG IS UNSUITABLE FOR THE SOCKET OUTLET IN YOUR HOME
THEN THE FUSE SHOULD BE REMOVED AND THE PLUG CUT OFF AND DISPOSED OF SAFELY.
THERE IS A DANGER OF SEVERE ELECTRICAL SHOCK IF THE CUT OFF PLUG IS INSERTED
INTO ANY 13 AMP SOCKET.
If a new plug is to be fitted please observe the wiring code as shown below.
If in any doubt please consult a qualified electrician.
WARNING: THIS APPLIANCE MUST BE EARTHED.
IMPORTANT: The wires in this mains lead are coloured in accordance with the following code.
Green-and-Yellow: Earth Blue: Neutral Brown: Live
As the colours of the wire in the mains lead of this appliance may not correspond with the coloured
markings identifying the terminals in your plug, proceed as follows.
The wire which is coloured GREEN-AND-YELLOW must be connected to the terminal in the plug which
is marked with the letter E or by the Earth symbol @ , or coloured GREEN or GREEN-AND-YELLOW.
The wire which is coloured BLUE must be connected to the terminal in the plug which is marked with the
letter N or coloured BLACK.
The wire which is coloured BROWN must be connected to the terminal in the plug which is marked with
the letter L or coloured RED.
How to replace the fuse: Open the fuse compartment with a screwdriver and replace the fuse.
SCREWDRIVER
. J
/ N
0 FOR USERS IN AUSTRALIA
This mark shows that the product complies with AS/NZS 3548.
N52
. J
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Before You Start

To avoid machine malfunction, do not use the equipment under the following conditions:

® Direct exposure to sunlight

32.5°C (50°F to 90.5°F)]

® Extremely high or low temperature [temperature range: 10°C to

® Extremely high or low humidity (humidity range: 20% to 80% RH)
® Condensation due to rapid change of temperature

® Areas of poor ventilation

® Areas of high dust or chemical
fume concentration (solvent
etc.)

® Unstable or unlevel surfaces

® Directly in front of air
conditioning vents

® | iquids near the equipment

® Too much media/document
which exceeds the limit mark
on the guide of the tray.

® Front/right/left doors opened
while the printer is operating; it
may cause a media jam.

=y

Not genuine toner

® Any toner other than genuine
Panasonic toner.
It may damage the printer.




Before You Start

m CD-ROM

To prevent the CD-ROMSs from accidental damages:

Q =
&5 %W +

® Do not touch or write on the ® Do not leave the disc out of the ® Do not leave the disc in direct
surface of the disc. protective case. sunlight or near heat sources.

® Do not place heavy objects on ® To clean the disc, hold the disc

the disc case or drop the case. by its edges and wipe it from
the center to the edges with a
dry, soft cloth.

m Static Electricity Damage

To prevent static electricity damage to any of the following components, touch a grounded metal surface,
such as the printer’'s bare metal frame prior to touching the component.

® The interface connectors : SCSI, parallel and optional network

® Electrical components, connectors inside the printer and any components on the optional board (RAM
Expansion Board or Ethernet Card)

® The connector pins on the optional 2nd cassette feeder for the printer

m Interface Cable

Always use a shielded interface cable. Use of an unshielded cable can result in radio interference with data.

m Waste Disposal Method

Waste material may be dumped or incinerated under conditions which meet all federal, state and local
environmental regulations.



Before You Start

Features

The KX-P8410 Color Laser Printer provides fast, high-quality color printing on plain
paper, plus the ease of operation and high performance you expect from a laser
printer.

Some of its features include:

m High quality
Resolution
Maximum 1200 dpi*

(* with SIMM options installed)

m High speed
Continuous printing on letter size/A4 size paper
Full-color mode: Maximum 3.5 ppm (pages per minute)
Monochrome mode: Maximum 14 ppm

m Easy operation
Printer driver
Easily print full-color documents.



Before You Start

System Requirements

PC

To operate the KX-P8410 effectively, see the following.

CPU:
Operating System:
RAM:

Free disk space:
Virtual memory:

Display:

Drive:

More than Pentium or Pentium PRO

(133 MHz or faster CPU is recommended.)

Windowso 3.1*, Windows 95*2 or Windows NTO 4.0%3*
(Intel Only)

16 MB or more (More than 32 MB is recommended.)

100 MB or more

16 MB or more (More than 32 MB is recommended.) for
Windows 3.1 /95

50 MB or more* (More than 100 MB is recommended.) for
Windows NT 4.0

Video card that can display more than 256 colors.

(A video card that can display more than 32,000 colors is
recommended.)

CD-ROM drive

*1 Microsofto Windowsr operating system Version 3.1 (hereafter Windows 3.1)
*2.Microsofto WindowsO 95 operating system (hereafter Windows 95)
*3 Microsofto Windows NTO Workstation operating system, and Microsoftd
Windows NTO Server network operating system Version 4.0
(hereafter Windows NT 4.0)
* Service Pack 3 or later version is required.
* |n the Virtual Memory window, change this setting in the Initial Size box.

Interface

One of the following can be used:

m Parallel interface requirement

Interface

Based on the IEEE P1284-C standard

(An ECP compatible parallel port is recommended
for Windows 95. To turn on the ECP mode, use the
computer’s BIOS setup. Refer to the computer’s
manual for details.)

m SCSI interface requirements

SCSI cable

SCSI-2 (FAST SCSI) compatible ([ P. 172)

SCSI-2 board

ASPI Manager compatible SCSI-2 board
(Adaptec AHA-2940 is recommended.)

ASPI| manager

ASPI Manager is required.

(Refer to the SCSI-2 board manual.)

15
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Before You Start

Minimum Space Requirements

Rear

45 cm (17.7") A

Multi-Purpose Tray v 35 cm (13.8")

Opening Space | Controller Board

T Opening Space
Left j Right
— —»
L

50 cm (19.7")
Media tray Opening

Front cover opening space

Power Source

® The voltage level of the power source must not vary more than £10% from the
voltage level marked on the nameplate (located on the back of the unit).

® Do not use an extension cord.

® Do not use a line conditioner, transient suppressor or surge protector as it may
cause a machine error.



Before You Start

Unpacking

Make sure that all of the items shown below were provided and have not been
damaged. Report damage or shortages to the reseller from which the unit was
purchased. Page 3 includes an area for recording important information such as the
name of reseller, serial number, and date of purchase.

Note:
® Save the original carton and packing materials for future shipping and
transporting of the unit. They have been specifically designed to protect the
equipment during shipment.

1. Printer (Color imaging unit, Fuser unit, Paper tray and Output tray are included.)
2. Toner cartridges (black, cyan, magenta, and yellow)
3. Power cord
4. KX-P8410 CD-ROM (includes Driver & Utility and Operating Manual)
5. Color Calibration Card
6. Setup manual
1 2 3

17



Before You Start

Part Names

mFront side view

Printer panel (0 P. 19)

=] E Right side door
‘ (O P.23,121)
gg Output tray ([0 P. 22)
o ol | # Media tray (0 P. 25)
04
Front door Fuser
(O P.21) (O P. 111, 116)
Imaging unit
(0 P.21,110)

m Rear side view

SCSI connector ( [1 P. 35)

SCSI ID NO. and
terminator switches (0 P. 37)

N

I Multi-purpose tray (MPT)
(O P.29)

= 71—/

=

I

TR

Left side door ( [J P. 29)
[Media thickness
switch* (O P. 29)]

—

Power switch
(0O P.38)

W

* Accessible by opening

AC inlet Parallel interface the left side door

(O P. 34, 36) connector ([0 P. 34)



Before You Start

Printer Panel Overview

(1]
/— \
(O READY e
. | ERORR
MENU 0/
[EXIT
| < A ENTER
Q CANCEL CONTINUE
(2] © (4 (5 (6

@ LCD (Liquid Crystal Display) panel
The printer LCD has two 24-character lines to display the printer’s status/error
messages or menu settings.

@ MENU/EXIT button
® \When the printer is ready, pressing this button enters the Menu mode.
® Pressing this button exits the Menu mode.

€@ <«/CANCEL button
® Pressing this button for 2 or more seconds cancels the data in the printer.
® \When the printer is in the Menu mode, pressing this button:
00 Displays the previous menu, item or selection.
O Decreases the current numerical value of the selection.
0 Moves the cursor to left.

@ A /CONTINUE button
® \When the printer is in the Menu mode, pressing this button:
O Displays the next menu, item or selection.
O Increases the current numerical value of the selection.
® \When error messages such as “Memory Overflow” or “SCSI Communication
Error” are displayed on the LCD, press this button to recover from an error
situation.

@ ENTER button
This button is effective only when the printer is in the Menu mode. Pressing
this button:
0 Enters a sub - menu.
O Activates a selection.

19
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Before You Start

@ ERROR indicator (orange)
® ON: an internal error (Call for Service Error) has occurred.
® Blinking: user correctable error, such as media jam, open door, or a missing
replaceable component (e.g. Toner) has occurred.

@ READY indicator (green)
® ON: the printer is ready for operation.
® Blinking: the printer is warming up or in the Menu mode.
® Blinking fast: the printer is printing.



Setup

Setting Up the Printer

Preparing the Imaging Unit

1 Open the front door.

Turn the upper green lever clockwise until it stops and the arrows
are aligned. (This tightens the internal belts to ready the unit for

printing.)

3 Close the front door.

21
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Setup

Setting Up the Output Tray

Remove the adhesive tape that holds the output tray against the
printer.




Setup

Installing the Toner Cartridges

Note:
® The toner cartridges that are shipped with the printer are starter cartridges.
They are installed in exactly the same manner as the optional cartridges; the
only difference is that the starter cartridges have less toner. (The page life
expectancy is 3,000 pages, which is based on a 5% image area.)

1 Remove the packaging from the toner cartridge.

2 Remove the shipping cover from the cartridge.

Caution:
® To avoid possible toner spillage, do not tilt cartridge.

Note:
® Save all packing material for shipping purpose.

3 Open the right side door.

Caution:
® Do not leave the right side door open for more than 1 minute; the imaging unit
will be exposed to light and could be damaged.

23
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Setup

4 Insert the toner cartridge in the appropriately labeled slot.

From top to bottom, the order of the color toner cartridges is BLACK, CYAN,
MAGENTA, YELLOW.

/]
)
N

S
=
\ S
NI

5 Repeat steps 1, 2 and 4 for each toner cartridge.

When you have installed all the toner cartridges, go to step 6.

6 Close the right side door.



Setup

Loading Media

Loading Paper or Transparencies in the Media
Tray

The printer uses five different trays:

Tray Size

A4 Paper 210 mm x 297 mm (8.3" x 11.7")

A4 Transparency 210 mm x 297 mm (8.3" x 11.7")

Letter Paper 216 mm x 279 mm (8.5" x 11")

Letter Transparency 216 mm x 279 mm (8.5" x 11")

Legal Paper 216 mm x 356 mm (8.5" x 14")
Notes:

® Make sure that you load the correct media. Each tray is designed and labeled
for only paper or transparency. If you load the incorrect media type in a tray, it
may cause a jam.

® /f you have the 2nd Cassette Feeder installed:

O If you wish to use the automatic cassette-switching feature (a large print job,
for example), make sure that all trays in the printer are the same media type
and size.

O The transparency tray should only be inserted in the upper or middle tray
slots.

The printer is shipped with a media tray (either Letter paper or A4 paper) installed.

1 Pull the media tray out of the printer.

Remove all packaging materials from inside the media tray; refer
to the instruction sheet attached to the tray.

25
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Setup

3 Push down on the metal plate until it clicks, locking it in place.

4 Fan the media (paper/transparencies), then tap it on a level
surface to avoid media jams or skewed printing.

~

Notes:

® To optimize your printer’s performance, always use clean, unused media.

® Be careful not to leave fingerprints on the media, which can result in a smudged
print.

® Reusing media that has been fed through the printer once (for example, after
Jjams) can reduce the life of the consumables and paper path components.

® The recommended transparency is 3M CG3700. If the print quality is poor, print
on the other side.



Setup

5 Place the media in the tray under the hooks.

The height of media should not exceed the limit mark on the tray, or it may
cause a jam.

Notes:
® [ oad media with the print side down. Most media has instructions
recommending the side to be printed first.
® Do not mix different types or thicknesses of media in the media tray at one time;
this may cause a jam.

6 Slide the media tray completely into the slot.

27
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Margins and Print Area

When the image is printed on the media, the image (print area) is a bit smaller than
the media size. You may need to adjust the page margins in the application software
to match the print area.

The following table and illustrations show the page sizes, the largest print areas, and
the margins for the media sizes supported on this printer.

) ) ) Margins
Media Page size Print area -
Top Bottom | Sides
Letter 216 mm x 279 mm | 208 mm x 269 mm | 5.6 mm | 5.6 mm | 3.6 mm
(8.5" x 11") (8.2" x 10.6") (0.22") | (0.22") | (0.14M)
Ad 210 mm x 297 mm | 200 mm x 287 mm | 5.1 mm | 4.7 mm | 4.7 mm
(8.3" x 11.7") (7.9" x 11.3") (0.2 (0.19") | (0.19M
Leqal 216 mMmx 356 mm | 208 MM x 343 mm | 5.8 mm | 5.8 mm | 3.6 mm
9 (8.5" x 14™ (8.2" x 13.5") (0.23") | (0.23") | (0.14M
Letter A4 Legal
208 mm (8.2") 200 mm (7.9") 208 mm (8.2")
o o _
S - in
£ £ 3
2 = £
N & ™
Q
—_ ™
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Loading Media in the Multi-purpose Tray

The multi-purpose tray (MPT) serves as an additional tray for loading any type of
media that ranges in size from 91 mm x 254 mm to 216 mm x 356 mm (3.6" x 10" to
8.5" x 14"). Use it to load a single sheet or a stack of media. The amount of media
you can load depends upon its thickness.

Use the multi-purpose tray to accomplish the following:

Print on standard and special media
e Standard media
O Laser paper [75 to 165 g/m? (20 to 44 Ibs.)]

® Special media
O Labels
O Envelope (#10 or larger size)* [Black Text only]
O Transparency (The print quality may not be stable. Use the media tray for
best reliability.)

* |f the Envelope is larger than #10, you must select a paper size that is larger than
your envelope.

Two-sided printing (double-sided) on laser paper
You should not expect the same print quality and reliability that you get with one-
sided printing. For details, refer to page 166.

Setting media thickness switch

Because the printer accommodates various media weights from the multi-purpose
tray, media thickness can be manually selected for the most reliable paper-picking.
Follow these steps:

Open the left side door (@). The green media thickness switch is
located on the paper feeder and has three settings:

W

2 Move the switch to the desired setting.

Switch setting Media
Thin (Default) Laser paper 75 to 90 g/m? (20 to 24 Ibs.)
. Laser paper 91 to 123 g/m? (25 to 32 Ibs.)
Middle
Transparency, Label
Thick Laser paper 124 to 165 g/m? (33 to 44 Ibs.)

Envelope

3 Close the left side door.
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mLoading Paper, Transparency

Notes:
® Reusing media that has been fed through the printer (for example, after jams)
can reduce the life of the consumables and paper path components.
® When printing legal size using the multi-purpose tray, backside marking may
occur. If this occurs, use the legal cassette.

For detailed information on media, refer to page 165.

l Set the media thickness switch (0 P. 29).

2 © Open the Multi-purpose tray.

@ Extend the media support by sliding it outward.

Separate the media guides to the approximate width of the
media.

4 Fan the media, and then tap it on a level surface to avoid media
jams or skewed printing.

~
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5 Insert the media with the printing side up into the multi-purpose

tray.
The height of media should not exceed the limit mark on the left guide, or it
may cause a media jam.

6 Adjust the media guides to the media size.

7 Use the printer driver to select the multi-purpose tray.
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mLoading an Envelope

Do not insert more than one envelope at a time. Only black text can be printed
on envelopes. For more detailed information on envelopes, refer to page 168

Note:
® The envelope may be creased when printed.

1 Set the media thickness switch (0 P. 29).
2 Adjust the media guides to the width of the envelope.

3 Insert the envelope with the short end entering the printer first
and the printing side facing up. The edge where the stamp is
located enters the printer last.

4 Use the printer driver to select Envelope in the Paper size menu
and the Paper source menu.

mLoading Labels

For detailed information on labels, refer to page 167.

1 Set the media thickness switch (O P. 29).
2 Adjust the media guides to the width of the label sheets.

3 Insert the label sheets in the multi-purpose tray with the printing
side up and the top of the sheets enter first.

The height of labels should not exceed the limit mark on the guide.

4 Use the printer driver to select Label.
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Connecting the Printer to a Computer

Only one PC can be directly connected to your printer.

Jesen
L J
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Using a Parallel Interface Cable

If you do not have a parallel interface cable, you will need to purchase one from your
local computer store or dealer ( [1 P. 171 for Parallel Interface specifications).

Make sure the computer, printer and the other connected
peripheral devices are turned off.

2 Connect the parallel interface cable to the computer’s parallel
interface connector and the printer’s parallel interface connector.

Computer’s parallel
interface connector

Notes:
® The actual connector on the computer may differ depending on the
manufacturer of the computer.
® /f the cable is connected to the PC via a printer buffer or selector, the printer
may not print.

3 Connect the power cord to the printer’'s AC inlet and to an AC
outlet.

‘:2

S@
\\\\
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Using a SCSI Cable

Note for Terminator setting:

® The printer must be the last device in the chain. The terminator setting of all
other devices in the chain must be off.

Make sure the computer, printer and the other connected
peripheral devices are turned off.

Connect the SCSI cable to the computer’s SCSI connector and
the printer’'s SCSI connector.

® A SCSI-2 board must be installed in the computer.

If you do not have a SCSI-2 board or a SCSI interface cable, you will need to

purchase one from your local computer store or dealer ([ P. 15, 172 “SCSI
Interface” specifications).

Computer’s SCSI ]
connector -

W

3 Make sure the SCSI ID No. of the printer is 1 (default setting).

e |[f you have other devices connected to the computer, make sure that each
SCSI device has a different ID No.

® To change the printer’s ID No., use the ID No. switches (#1, #2, #3) located
on the back of the printer. Also refer to Table 1 on page 37.

A N
SE
Lm

1
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4 Make sure the terminator switch (#4) of the printer is set to ON
(default setting).

5 Connect the power cord to the printer’s AC inlet and to an AC
outlet.
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m Setting the SCSI ID Number

In most cases, there is no need to change the default settings.
However, if you have other peripheral devices connected in a SCSI chain, check if
their ID numbers conflict with that of the printer. Be sure to choose an unassigned 1D

number.

ID number can be changed by using the SCSI ID No. switches (#1, #2, #3) [ O Table

1 below].
Table 1
. SCSI ID No. switches
#1 #2 #3
0 OFF OFF OFF
1 ON OFF OFF
2 OFF ON OFF
3 ON ON OFF
4 OFF OFF ON
5 ON OFF ON
6 OFF ON ON
7 ON ON ON

m Setting the Terminator

M M
O[T )=
N — SCSI ID No.
w switches
F I
U |

Terminator switch

The terminator setting can be changed by using the terminator switch (#4).

Terminator ON:

Terminator OFF:

A N
2/ I+
)
I
U |
A N
oM [
)
N
U |
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l Turn ON the printer, then the computer.

))
o | E— o

EEEE

}

2 © The READY indicator on the printer starts flashing and
“Initializing” is displayed on the printer LCD panel.

@ After approximately 3.5 minutes, the printer’'s READY indicator
is illuminated and “Ready” is displayed on the printer LCD
panel.

The printer is ready for printing.

Note:
® When you power on your system for the first time, if “New Hardware Found” is

displayed on the computer screen, refer to page 43.
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Printing a Test Page From the Printer Panel

The test page provides general information on printer settings and configuration.
Make sure the printer is ready and paper is loaded. Use the following procedure to
print a test page.

1 Press the MENU/EXIT button to enter the Menu Mode.

Menu Mode
Test Page

2 Press the ENTER button.

Test Page
Configuration Page

3 Press the ENTER button again.

The printer will start printing a configuration page:
(Example)

Panasonic Color Laser Printer

Model Name : KX-P8410

Printer Rom Version No. : VXXX : MBXXXX (R019)
Installed Memory : 008 MBytes

Installed Cassette : Media Tray - Letter

< Panel Settings >

System Setting Energy Star on
Auto Continue off
Data Time Out off

Maintenance Page Count 0000000000
Color Imaging Unit 000%
Transfer Unit 000%
Fuser Unit 000%
0il Supply Roll 000%

Color Calibration OFFSET 00
CYAN 00
MAGENTA 00
YELLOW 00
BLACK 00

(C) 1996-1998 Kyushu Matsushita Electric Co.,Ltd.

/\—/
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Installing the KX-P8410 Software

The KX-P8410 software installation will create the following.

® Printer driver for Windows 3.1, Windows 95 or Windows NT 4.0 ( [J P. 41, 42, 45)
® Status Display for Windows 3.1, Windows 95 or Windows NT 4.0 ( [0 P. 152)

Note:
® /f you are using Windows 3.1, disable or uninstall any application software’s
printer status to prevent conflicts with the KX-P8410 Status Display for
Windows 3.1.
® When reinstalling the KX-P8410 software, do it immediately after restarting
Windows.
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Installing the Printer Driver and Utilities for
Windows 3.1

Start Windows 3.1.
2 Quit all applications.

3 Insert the KX-P8410 CD-ROM into your computer’s CD-ROM
drive.

Click [File |from the Program Manager, then click[Run...|.

5 Click [Browse | and select your CD-ROM drive from the [Drives:]
box.

6 Select Setup.exe, and click.

7 Click [OK].

The Installer starts.

Follow the instructions on the screen to complete the installation.
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Installing the Printer Driver and Utilities for
Windows 95

1 Start Windows 95.

2 Quit all applications.

3 Click  Start |, move the pointer to Settings, then click
Control Panel.

The Control Panel window is displayed.

4 Double click| Add/Remove Programs |.

The Add/Remove Program Properties window is displayed.

5 Click [Install .

The Install Program From Floppy Disk or CD-ROM window is displayed.

6 Insert the KX-P8410 CD-ROM into CD-ROM drive.

7 Click [Next>] .

The Run Installation Program window is displayed.

fo Click [ Finish].

Wait until the Panasonic KX-P8410 Utilities Welcome window is displayed.

9 Follow the instructions on the screen to complete the installation.

After installation, restart your system.

Note:
® During installation, when “Setup is adding icon to the Printer folder. Please wait
several minutes” is displayed, the processing may take approximately 5 to 10
minutes to complete depending on the system.
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m Using Plug and Play

S 00 AN W@

~N

10
11

12

Turn on the printer.

Turn on the computer and start Windows 95.

The New Hardware Found window is displayed for a few seconds, then the
Update Device Driver Wizard window is displayed.

Insert the KX-P8410 CD-ROM into CD-ROM drive.

Click [Next>].

“Windows was unable to locate a driver for this device” is displayed.

Click |Other Locations... |.

Type in your CD-ROM drive name followed by :\Win95\Disk2
(example; D:\Win95\Disk?2) in the Location field and click

OK].
Click [Finish |.

The Insert Disk window is displayed.

Click [OK].

The Copying Files window is displayed.

Type in your CD-ROM drive name followed by :\Win95\Disk?2
(example; D:\Win95\Disk?2) in the Copy File from field and click

.
Click [OK ].

The Select SETUP.EXE window is displayed.

Click[OK] . Select SETUP.EXE included on the KX-P8410 CD-
ROM in your CD-ROM drive and then click[Open] .

Wait until the Panasonic KX-P8410 Utilities Welcome windows is displayed.

Follow the instructions on the screen to complete the installation.

After installation, restart your system.

Note:
® The Plug and Play installation procedure varies depending on the version of

Windows 95. Refer to Help in Windows 95.
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m Using Add Printer

1
2

© 0 N O O A

Start Windows 95.

Quit all applications.

Click , move the pointer to Settings, then click Printers.

The Printers window is displayed.

Double click the Add Printer icon.

Install the KX-P8410 CD-ROM into CD-ROM drive.

Click[ Next>].

Select Local printer or Network printer and then click| Next> |.

Click |Have Disk...].

Type in your CD-ROM drive name followed by :\Win95\Disk2
(example; D:\Win95\Disk?2) in the Install From disk field and

click [OK|.

10 Click [Next> |.

11

Follow the instructions on the screen to complete the installation.

After installation, restart your system.

Notes:

® The above “Using Add Printer” procedure installs only the printer driver. It does
not install the Status Display program.

® After installing the printer driver, it will take several minutes for the printer to
register and display in Printers Folder.
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Installing the Printer Driver and Utilities for
Windows NT 4.0

10

11

Start Windows NT 4.0.

Quit all applications.

Click| Start |, move the pointer to Settings, then click
Control Panel.

The Control Panel window is displayed.

Double click| Add/Remove Programs |.

The Add/Remove Program Properties window is displayed.

Click | Install |.

The Install Program From Floppy Disk or CD-ROM window is displayed.

Insert the KX-P8410 CD-ROM into CD-ROM drive.

Click [ Next>] .

The Run Installation Program window is displayed.

Click [Finish].

Wait until the Welcome window is displayed.

Click [Next>] .

The Choose Destination Location window is displayed.

Click the type of setup, then click :

The Select Program Folder window is displayed.

Click [Next>].

The Start Copying Files window is displayed.
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12

13
14

15
16

17
18

19

20
21

22

Click [Next>].

After copying files, the Add Printer Wizard window is displayed.
Click .

Select LPT port by clicking on the check box.

Click [Next>].

Click |Have Disk...] .

The Install From Disk window is displayed.

Click .

Click .

The Locate File window is displayed.

Select CD-ROM drive.

Open Winnt40, Disk2, then select Pgdinta.inf file.

Click .

Follow the instructions on the screen to complete the installation.

® To connect the printer to a SCSI port, the SCSI port needs to be installed.
Refer to the Ports tab of the Panasonic KX-P8410 Properties window
(0O P.88to91).
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Installing the SCSI Port:

Notes:
® |t [s recommended that you do not connect the printer directly to the file server.
Otherwise the printer and server performance may be diminished.
® When printing through the SCSI port, the access speed between other
connected SCSI devices is diminished.
® To connect the KX-P8410 to your SCSI port, a SCSI driver and ASPI Manager
must be installed. Refer to your SCSI board manual.

1 Click , select Settings, then click Printers.
2 Click the Panasonic K X-P8410 icon.

3 Click the File menu, then click Properties.
The Panasonic KX-P8410 Properties window is displayed.

4 Click the Ports tab.

5 Click[Add Port...] .

The Printer Ports window is displayed.

6 Click [New Monitor...|.

The Installing Print Monitor window is displayed.

7 Insert the KX-P8410 CD-ROM into CD-ROM drive.

8 click[Browse..]

Q Click [Cancel].

The Locate File window is displayed.

Note:
® The SCSI port cannot be installed through the Monitor.inf file when copied to a
directory with long file name.
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10
11

12

13

14

15

Select CD-ROM drive.

Open Winnt40, Disk2, then select Monitor.inf file.

Click .

The Installing Print Monitor is displayed.

Click [OK].

The Printer Ports window is displayed.

Click| New Port....|.

The Port Name window is displayed.

Type the port name (for example; KXP8410GDI), then click [OK |.

The Printer Ports window is displayed.

Click [Close].
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m Using the Printer in a Network Environment

For the server computer:

To share the printer with other clients on the network, perform the following steps
after installing the printer driver.

1 Double click the My Computer icon.

2 Double click the Printer icon.

Select the Panasonic KX-P8410 printer.
Click File menu, then click Sharing... .

Click Shared.

S OO0 AN W

Enter the printer name (ex. KX-P8410).

If the shared printer is used through Windows 95, the printer name must not
exceed 12 characters.

7 Click [OK] .
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For a client computer:

To use the printer connected to the server, perform the following steps after installing
the printer driver.

< For Windows NT 4.0 Users >

] Click[Start], move the pointer to Settings and click Printers.
2 Double click the Add Printer icon.

3 Select Network printer server.

/] Click .

5 Select the Panasonic KX-P8410 printer in the Shared Printers
box.

6 Click and follow the instructions on the screen.

7 Click [Finish .

< For Windows 95 Users >

l Double click the My Computer icon.
2 Double click the Printersicon.

3 Double click the Add Printer icon.

/] Click [Next>].
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11
12
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14

15
16

Click Network printer, then click :

Click .

Select the KX-P8410 printer.

Click [OK |.

Click .
If the server does not have the Printer Driver for Windows 95, click

-

The Install From Disk window is displayed.

Click -

Insert the KX-P8410 CD-ROM into CD-ROM drive.

Select the CD-ROM drive.

Open Win95, Disk2, then select KXP8410.inf file. Click :

The Printer Drivers for Windows 95 window is displayed.

Click[ OK].

The Install From Disk window is displayed.

Click [OK |.

Click .

17 Click [Finish].
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m Removing the Printer Driver

1 Click [Start |, move the pointer to Settings and click Printers.

2 Select Panasonic KX-P8410.

3 Click File menu, then click Delete.

/] Click [Yes |.
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Removing the KX-P8410 Software

If you need to remove the KX-P8410 software, perform the following steps.
mFor Windows 3.1 users:

1 From the Program Manager double click the Panasonic
K X-P8410 Utilitiesicon.

2 Double click the Uninstall Utilitiesicon.
3 Click [ Yes].
4 Follow the instructions on the screen.

mFor Windows 95/ Windows NT 4.0 users:

1 Click , move the pointer to Programs, then to
KX-P8410 Utilities.

2 Click([Uninstall].

3 Click [ Yes .

4 Follow the instructions on the screen.

Note:

® [or removing the Panasonic KX-P8410 icon in the Printer Folder, refer to Help
in Windows 95 / Windows NT 4.0.
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Installing Panasonic Font Manager

The Panasonic Font Manager is included in the KX-P8410 CD-ROM.

To install the above application, perform the following steps.
mFor Windows 3.1 users:

l Start Windows 3.1.
2 Quit all applications.

Insert the KX-P8410 CD-ROM into your computer CD-ROM drive.

4 Click[File] from the Program Manager, then click[Run...|.

Click|[Browse ] and select your CD-ROM drive from the [Drives:]
box.

Select Install.exe in the Font directory, and click [OK ].

)

Click [OK].

The installer starts.

~N

8 Follow the instructions on the screen to complete the installation.
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mFor Windows 95/ Windows NT 4.0 users:

1 Start Windows 95 / Windows NT 4.0.

2 Quit all applications.

Insert the KX-P8410 CD-ROM into your computer CD-ROM drive.
Click [Start |, move the pointer to Run..., then click[Run].

Click and select your CD-ROM drive.

Select Install.exe in the Fonts folder, and cIick.

Click [OK].

The installer starts.

N O O A W

8 Follow the instructions on the screen to complete the installation.

Note:
® When you insert CD-ROM into your drive, application installer may start

automatically. In this case, quit the Panasonic quick installer and use the
application installer.

For information on how to use the applications, refer to their manuals.
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Setting the Color Density

The printer panel provides an interface to adjust the density of the toner applied to
the media. This feature compensates for the changes in density that can occur as
environmental conditions changes, toner cartridges or the imaging unit age.

READY
O =

|| ERORR
MENU =
JEXIT

| ENTER

@ |__<_| CANCEL |i| CONTINUE :|
< A

MENU/EXIT ENTER

Perform the following steps to adjust the color density:

1 To print a Color Calibration Page:

@ Press the MENU/EXIT button on the printer panel.

Menu Mode
Test Page

@ Press the A button.

Menu Mode
Color Calibration

© Press the ENTER button.

Color Calibration
Calibration Offset

O Press the A button 5 times and the following is displayed.

Color Calibration
Calibration Test Print

@ Press the ENTER button.
A Color Calibration Page will be printed.
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The current density setting for each color is indicated by the line enclosure on the
Color Calibration Page as shown in the following example.
The factory default setting for each color density is O.

Color Calibration Page (Example):

— Current color
density settings
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2 Compare the current color density settings on the Color
Calibration Page with the color density samples on the Color
Calibration Card to see if they match.

Place the Color Calibration Page on at least 2 sheets of clean white paper in a
well-lighted area.

Color Calibration
Card

Color Calibration
Page

® |[f they match, then you do not need to adjust the color density
and you may proceed with any operation you wish to perform.

® |f they do not match, go to step 3.

3 Determine which block on the Color Calibration Page most
closely matches the density of the cyan sample on the Color
Calibration Card.

® Repeat step 3 for each color.
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4A If you wish to adjust the density for all colors simultaneously,

perform the following, then go to step 5.

© Repeat instructions @ through @ of step 1 on page 56.

Color Calibration
Calibration Offset

@ Press the ENTER button.

Calibration Offset
0* (-5 to 5)

© Press the A/« button to darken/lighten all the colors.
Pressing the A/ < button twice selects the next/previous level settings.
(For example:)
® |f you wish to make the density setting darker by 2 levels:
O Press the A button 4 times.
e |[f you wish to make the density setting lighter by 1 level:
O Press the « button 2 times.

O Press the ENTER button.

Color Calibration
CYAN

@ Press the A button 4 times and the following is displayed.

Color Calibration
Calibration Test Print
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4B If you wish to adjust the density for each color independently,

perform the following, then go to step 5.

@ Repeat instructions @ through @ of step 1 on page 56.

@ Press the A button.

Color Calibration
CYAN

€ Press the ENTER button.

CYAN
0* (-10 to 10)

O Press the A/« button to darken/lighten the cyan color.

Pressing the A/« button twice selects the next/previous level setting.
(For example:)
® |[f you wish to make the density setting darker by 4 levels:
O Pressthe A button 8 times.
® |f you wish to make the density setting lighter by 2 levels:
O Press the <« button 4 times.

@ Press the ENTER button.

Color Calibration
MAGENTA

@ Repeat instructions @ through @ for each color
(MAGENTA, YELLOW, BLACK).

® To skip a color, press the A button.
® To return to a previous color, press the <« button.
® Before going to step 5, make sure the following is displayed.

Color Calibration
Calibration Test Print

5 Press the ENTER button to reprint the Color Calibration Page.

® The line enclosure reflects the changes made to the settings.
e |f you are not satisfied with the current color density settings, repeat steps 4
and 5 above.

Notes:

® The color density setting affects the average life of toner.
® Save the Color Calibration Card for future calibrations.
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The Menu mode includes a Main menu, Item menu, Selection 1 menu and Selection
2 menu which can be changed from the printer panel.

When Ready is displayed in the upper line of the LCD, pressing the MENU/EXIT
button will allow you to enter the Menu mode.
Once in the Menu mode:
® Press the A/CONTINUE button to:

O Display the next menu.

O Display the next item.

O Increase the numerical value of the selection by 1 or display the next selection.
® Press the €/CANCEL button to:

O Display the previous menu.

O Display the previous item.

O Decrease the numerical value of the selection by 1 or display the next selection.
® Press the ENTER button to:

O Enter a sub - menu.

O Activate a selection.

O Print a Configuration/Maintenance/Color Calibration Page.

Before you attempt to change any settings, check the factory default settings in the
following table. For details on changing the settings, refer to Outline for Operation
(0 P. 64).

Once you have changed the printer panel settings, they are automatically saved as
user default settings even if the power is turned off.

Main Menu Item Menu Selection 1 Menu | Selection 2 Menu
Test Page Configuration Page
Maintenance Page CYAN
MAGENTA
YELLOW
BLACK
Color Calibration | Calibration Offset 0* (-5 to 5)
CYAN 0* (-10 to 10)
MAGENTA 0* (-10 to 10)
YELLOW 0* (-10 to 10)
BLACK 0*t (-10 to 10)
Calibration Test Print
Reset Calibration YES
NO

(continued)
*1 Factory default setting
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Main Menu Iltem Menu Selection 1 Menu | Selection 2 Menu
System Setting Energy Star ON*
OFF
Auto Continue ON
OFF*
Data Timeout ON 30* (30 to 240s)
OFF*

Network *?

IP Address

XXX XXX XXX XXX

Subnet Mask

XXX XXX XXX XXX

Default Gateway

XXX XXX XXX XXX

Maintenance

Page Count

XXXXXX

Imaging Unit

Usage=xx%

Transfer Unit

Usage=xx%

Fuser Unit

Usage=xx%

Oil Roll

Usage=xx%

*1 Factory default setting

*2 This menu appears when the optional network card is installed.

Outline for Menus

Test Page

Prints the Configuration Page and Maintenance Page.

m Configuration Page

Prints general information on printer settings and configuration.

m Maintenance Page
Prints each color (Cyan, Magenta, Yellow or Black) halftone to check for print
quality.

Color Calibration
Adjusts the toner density for each color independently or all colors.

m Calibration Offset
Adjusts the density for all colors (CYAN, MAGENTA, YELLOW and BLACK).
Setting a higher number provides darker colors and setting a lower number
provides lighter colors.

mCYAN / MAGENTA / YELLOW / BLACK

Adjusts the density for each color independently. Setting a higher number provides

darker color and setting a lower number provides lighter color.
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m Calibration Test Print
Prints a Color Calibration Page with the current density settings.

m Reset Calibration
Setting YES resets the current settings back to the default settings.

Note:
® The color density setting affects the average life of toner.

System Setting
Configures the printer.

m Energy Star
To conserve energy and operating cost, this printer is provided with a
programmable power save feature. Printer is factory set with the power save
feature turned on.
If Energy Star is enabled, the printer enters the Energy Star mode when the printer
is idle for 30 minutes.

m Auto Continue
With the Auto Continue set to ON, the printer automatically recovers from the
following error condition if no recovery operation is done for 10 seconds.
® Memory Overflow

m Data Timeout
With the Data Timeout set to ON, the printer automatically returns to Ready status if
the printer does not receive any data from a computer within the time period set in
this selection (30 to 240 seconds).

Network

Sets the addresses used in TCP / IP Protocol. During setting, use the €/CANCEL
button to move the cursor and the A/CONTINUE button to increase the numerical
value.

Maintenance

Displays the page count of the printer and the consumption of supplies. It also gives
you an idea when the following supplies need to be replaced. The following table
shows the average life of each supply, which is based on a 5% image area and
standard density. Refer to pages 110 and 111 for detalils.

Supplies Average life

Monochrome (60,000 pages)
Color (15,000 pages)

Imaging Unit **

Transfer Unit 80,000 pages
Fuser Unit 31,000 pages™
Oil Supply Roll **| 15,500 pages

*When a supply is replaced with a new one, the printer will automatically reset the
page counter for that supply to 0.

*2 Transparencies, coated paper and other specialty media will result in shortening
the life of a consumable.
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Outline for Operation

Printer Panel
O READY
|| ERORR
MENU =
[EXIT
| « A ENTER
@ CANCEL CONTINUE
[
MENU/EXIT | A ENTER

Press the MENU/EXIT button to enter the Menu mode.

Press the A/« button until the desired menu is displayed.

Press the ENTER button to enter the item menu.

Press the A/« button until the desired item is displayed.

Press the ENTER button to enter the Selection 1 menu.

G KA W N kR

® |[f you have selected Configuration Page or Calibration Test Print in step 4,
the printer will exit the Menu mode after printing the page.

6 Press the A/« button to increase/decrease the numerical value
or display the desired selection.

7 Press the ENTER button to activate your selection and advance
to the next item in the same menu that you selected in step 2.

® |[f you have selected Maintenance Page in step 4, the printer will exit the
Menu mode after printing a maintenance page in the selected color.

® |[f you have selected Data Timeout in step 4, you will enter the Selection 2
menu. Press the A/« button to increase/decrease the data time out, then
press the Enter button to activate your selection and exit the Menu mode.
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If you wish to set more items in the same menu, repeat steps 4 to
7 above.

® To exit the Menu mode at any stage, press the MENU/EXIT button.
® To change the setting of an item of a different menu, first exit the Menu
mode, then repeat steps 1 to 8 above.
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Displaying the Panasonic KX-P8410 Window (for Windows 95/ 3.1)

The KX-P8410 window can be displayed from Windows ( 0 below) or from an
application ([ P. 68).

Note:

® Available option tabs and operation buttons displayed through Windows 95 are
different from those displayed through Windows 3.1.

I[N Choosing Printer Properties Under Windows:
m For Windows 95
1 Click [ Start |, select Settings, then click Printers.

The Printers window is displayed.

2 Click the Panasonic K X-P8410 icon.

3 Click the File menu, then click Properties.
The Panasonic KX-P8410 Properties window is displayed.

Panasonic KX-PB410 Properties [ 7]

General l Details] Paper ] E!ualit_l,l] Elptinn] Memu:ur_l,l]

\:ij FPanazonic Fx-FE410

Commet; ‘

Separator page; |[r'u:|ne] ﬂ Browse. ..

Print Test Page |

0k | Cancel | |
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Click a tab to view the features.

Details Tab ( [J P. 69)
Paper Tab (O P. 70)
Quality Tab (O P. 72)
Option Tab (O P. 74)
Memory Tab (O P. 76)

mFor Windows 3.1

1

Printersicon.

The Printers window is displayed.

2

Double-click Main icon and Control Panel icon, then double-click

Select Panasonic KX-P8410 on LPT1*, then click :

The Panasonic KX-P8410 window is displayed.
* The port name (LPT1) may vary depending on the connection of your printer.

Panasonic KX-F8410 Properties

Paper Cuality Option bl ernonyg
Paper Size
| | =
A4 Legal Envelope

Orientation

ﬂ ® Portrait

Output Order

I (8 Face Down

2
- (! Landscape

(" Face Up

Paper Source:

LCopies:

|Autn [Plain Paper)

=

E

| Hestore Defaults |

Cancel

..........

About

Help |
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3 Click a tab to view the features.

Paper Tab (0 P. 70)
Quality Tab ([0 P. 72)
Option Tab (O P. 74)
Memory Tab (O P. 76)

BElFrom an application

For example, to print a document created in Microsoft WordPad in Windows 95,
perform the following steps.

1

Click , select Programs, select Accessories, then click
WordPad.

The WordPad window is displayed.

Click the File menu, then click Print... .

The Print window is displayed.

Select Panasonic KX-P8410 in the Name : box.

Click [Properties .

The Panasonic KX-P8410 window is displayed.

Click a tab to view the features.

Paper Tab (0 P. 70)
Quality Tab (O P. 72)
Option Tab (O P. 74)
Memory Tab (O P. 76)

Note:

® The print options in the File menu depend on the Windows application. Refer to

the application manual.

(

The instructions described hereafter are based on Windows 95. However,
most instructions for Windows 3.1 are the same as Windows 95.
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Details Tab

Note:
® This option is available only in Windows 95.

Panaszonic KX-PB410 Properties [ 2]

Gereral Details l Paper ] Dualit_l,l] Elptin:nn] Memn:nr_u]

“E

Fanazonic Fx=-F3410

ﬂ Add Part....
Delete Port. ..

Print uging the following driver:

Panazonic K=-PE410 ﬂ Mew Driver. .

LCapture Printer Fart. . | End Capture... |

Timeout zethings

Mot zelected: 15 seconds
Tranzmizzion ety |45 zeconds

Spool Settings... | Fort Settings... |

OF. | Canizel | |

@ Print to the following port
Select the port where the parallel interface cable is connected.
When you are using the SCSI interface cable, select the KX-P8410GDI
(KX-P8410 on SCSI).

For the functions of other buttons, refer to the Help menu in the
Windows.
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Paper Tab

Panazonic KX-P8410 Properties

General] Detail: Faper lDuaIit_l,I] Elptiu:un] Memu:ur_u]

Q@ Papersizer  Letter81/22111n
0 d =

A4 Leqal Envelope

@ ———————— Orientation

i |
Alr Partrait Alr Landscape

©———— Output order

__l * Face down _E " Face up
O Paper souce: |.-'5‘-.utl:| [Plain Paper) ﬂ
@ — Copiex: 1 ﬂ
About. .. | Restore Defaults |

(] ] Cancel | Apply |

(6] (7]

@ Paper size
Selects a different paper size.
Letter, A4, Legal or Envelope can be selected.

@ Orientation
Selects Portrait (vertical) or Landscape (horizontal).
Portrait Landscape

A A

© Output order
Specifies whether the document prints face up or face down in the output
tray. This selection is not effective when the multi-purpose tray (MPT Plain
Paper, MPT Transparency, etc.) is selected in the Paper source (O P. 71).
When the multi-purpose tray is selected, Face up is selected automatically.
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@ Paper source
Selects media by choosing the location (trays) or the type of media.

® Auto [Plain Paper]:
Prints on paper loaded in a paper tray. The printer picks paper from the
paper tray that loaded with the media size you selected in an
application software. When the tray is empty, the printer automatically
picks from another paper tray of the same media size in the order of
Upper, Middle and Lower.

® Auto [Transparency]:
Prints on transparency loaded in a transparency tray. The printer picks
transparency from the transparency tray that loaded with the media
size you selected in an application software. When the tray is empty,
the printer automatically picks from another transparency tray of the
same media size in the order of Upper, Middle and Lower.

® Upper :
Prints on media loaded in the standard tray.

e Middle* :
Prints on media loaded in the upper tray (optional feeder).

® | ower*:
Prints on media loaded in the lower tray (optional feeder).

® MPT Plain Paper, MPT Transparency, MPT Label, MPT Coated
Paper, MPT Envelope, MPT Paper 2nd Side :
Prints on paper, transparency or label , etc. loaded in the Multi-purpose
tray. The printer will print on the selected media with optimal quality.

* If the optional feeder has not been installed, the printer selects the
standard tray automatically.

@ Copies
Determines how many copies of the document will be printed.

Note:
® The number of copies can be also determined using some application
softwares. However, it is recommended to set the number of copies using
one method, either from this driver or from an application software to
avoid having a printing problem.

@ About... button
Displays the window which contains the program version and copyright
information.

@ Restore Defaults button
Resets the Paper tab’s settings to the default settings.
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Quality Tab

Panazonic K2{-P28410 Properties [ 2]

General] Details] Paper Oualiy l Elptinn] Memu:ur_l,ll

@ Fiint style:
e D
& L
Black Text [Gray Scale Color Graphics Colar Ph
( >
@ Dithering mode: |Default ﬂ

O —Fint quiality
" Fast (300 dpi)

{+ Standard [B00 dpi)
" High guality [1200 dpi]

Abaut, ., | Fieztore Defaults |

] -| Cancel | |

o (5]
@ Print style
Select a type which is the closest to your document to print for optimal
quality.
® Black Text:

Prints the document in black and white the quickest. Select this for
black and white text files.

® Gray Scale:
Prints the document in black and white. Select this for monochrome
halftone images.

® Color Graphics: (default)
Prints the document in color. Select this for computer graphics, colored
text, and spreadsheets with color graphics.
Small text can be printed more clearly than when printed in
Presentation.

® Color Photo:
Prints the document in color. Select this for photo images such as a
photo from a CD.

® Presentation:
Prints the document in color. Select this for presentation printing.
Presentation provides a clearer tone than Color Graphics.
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@ Dithering mode
Color Graphics and Color Photo are print styles that simulate shades of
color by changing the dot patterns. You can select a dot pattern using
Default*, Dither A or Dither B.
This selection is effective only when Color Graphics or Color Photo is
selected.

* Most appropriate Dithering mode may be automatically selected according
to the print style, print quality and printer memory you have selected.

Notes:

® When Color Graphics is selected in the Print Style, Dithering mode is
available for all print quality selections.

® When Color Photo is selected in the Print Style, Dithering mode is available
only for 600 dpi and 1200 dpi print quality selections.

@ |f the error message “Memory Overflow” appears when Default or Dither B is
selected, change the selection to Dither A. With Dither A selected, memory
overflow may not occur.

© Print quality
Selects a print quality. Fast (300 dpi), Standard (600 dpi) or High quality
(1200 dpi) can be selected. A higher resolution provides better print quality.
However, the throughput speed is diminished.

When Presentation is selected in the Print style, print quality cannot be
selected and 300 dpi is automatically assigned.

O About button

Displays the window that contains the program version and copyright
information.

@ Restore Defaults button
Resets the Quality tab’s settings to the default settings.
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@ Color management

@®—————— Density [for Gray Scale]

®©———1  Fiint as a mirmor image

Option Tab

Panasonic KX4-P8410 Properties EH

General] Details] FPaper ] Quality  Dption l Memu:ur_l,l]

v Usze Hyper-Tetra Adustment Adjustment... |

[ Use image color matching [ICH) |

v Uze denzity adjustrment Density. .. |

About. .. | Restore Defaults |

| k. ] Cancel | |

(4] 5]

@ Color management

This feature provides two-color adjustment functions as described below.
These functions are effective only when printing a document with Color
Graphics, Color Photo or Presentation print style.

® Use Hyper-Tetra Adjustment
Adjusts the brightness, contrast, hue, saturation, or red, green, blue, or
cyan, magenta, yellow, black of the image. For the adjustment, refer to
Using the Hyper-Tetra Adjustment ( [J P. 97).

® Use image color matching (ICM)**
The printer assigns the best color possible to represent the original
color accurately by selecting different rendering intents (Saturation,
Contrast or Colormetric). Click on this check box, then click the
Rendering intent button. The Rendering intent window appears. Select
the desired rendering intent, which determines how the printer assigns
the color.

*1 This option is available only for Windows 95.
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@ Density (for Gray Scale)
Adjusts the density of the gray scale image. This function is effective only
when the Gray Scale print style ( [ P. 72 Quality Tab) is selected.
For the adjustment, refer to Using the Density Adjustment ( [J P. 102).

@ Print as a mirror image
Clicking on this check box allows you to print a mirror image of the
document.

O About button

Displays the window that contains the program version and copyright
information.

@ Restore Defaults button
Resets the Option tab’s settings to the default settings.

75



76

Using the Printer

Memory Tab

Panasonic K2-P8410 Properties EH
General] Details] Paper ] Dualit_l,ll Option  Memory l

@ PFiinter memony:
@ Frinter memany usage:

o |z printer memony to make print performance better

~

Ahout,. | Festore Defaulkz |

OF. Canizel | |

(3] (4]

@ Printer memory
Selects the amount of memory installed in the printer. If the amount of
memory in the printer does not match this setting, a MEMORY
OVERFLOW message might be displayed. To determine how much
memory is installed in the printer, print out the Test page ( O P. 39).
As the printer memory increases, printing throughput improves. If the total
printer memory is set more than 32 MB, Use printer memory to make
print quality better can be selected in the Printer memory usage box.
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@ Printer memory usage
Determines how the printer memory is used, either for better print
performance or for better print quality. This selection is effective only when
the Gray Scale or the Color Photo print style is selected and the
Standard (600 dpi) is selected.
® Use printer memory to make print performance better

Sends the data to the printer with the standard level of compression to

improve throughput.

® Use printer memory to make print quality better
Sends the data to the printer with the lower level of compression or
without compression to improve the print quality. However, the
throughput will be diminished. More than 32 MB is required on the

printer to select this option.

© About button
Displays the window that contains the program version and copyright

information.

O Restore Defaults button
Resets the Option tab’s setting to the default setting.
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Displaying the Panasonic KX-P8410 Default Document

Properties Window (for Windows NT 4.0)

The KX-P8410 Default Document Properties window can be displayed from Printers
under Windows ( [J see A below) or from an application
(O see B on page 79).

From Printers Under Windows NT 4.0

Click , select Settings, then click Printers.

The Printers window is displayed.

2 Click the Panasonic K X-P8410 icon.

3 Click the File menu, then click Document Defaults....

The Panasonic KX-P8410 Default Document Properties window appears.

& Panazonic K2-P3410 Document Settings -
- -f?_ﬁ Paper/Output
=] Faper Size: <Letter:
4] Orientation: <Portraits
] Paper Source: <duto [Plain Paper]>
[ Copy Count: <1 Copy
- ks Document Options
@] Frint Style: <Color Graphicss
_'| Frint Guality; <Standard (500 dpi)>

[#] Dithering Made: <Defaultr -

Change 'Paper Size' Setting

=] A4
[ Envelope #10
=] Leaal
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4

Click a tab to view the features.

Page Setup Tab (O P. 80)
Advanced Tab ([0 P. 82)

E} From an application

For example, to print a document created in Microsoft WordPad on Windows NT 4.0,
perform the following steps.

1

5

Click| Start |, select Programs, select Accessories, then click
WordPad.

The WordPad window is displayed.

Click the File menu, then click Print... .

The Print window is displayed.

Select Panasonic KX-P8410 in the Name : box.

Click[Properties |.

The Panasonic KX-P8410 Document Properties window is displayed.

Click a tab to view the features.

Page Setup Tab (U P. 80)
Advanced Tab (U P. 82)

Note:

® The print options in the File menu depend upon the Windows application. Refer

to the application manual.
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Page Setup Tab

4% Panasonic KX-P8410 Default Document Properties

Q@ PaperSize | =] Letter j
@——— Paper Source: | 4] Auta [Plain Paper] j
©———— CopyCount [1 El: Copy

[1-939]
O——— Orientation

o+ Portrait " Landscape

0k, | Cancel

@ Paper Size
Selects a different paper size.
Letter, A4, Legal or Envelope #10 can be selected.
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@ Paper Source
Selects media by choosing the location (trays) or the type of media.

® Auto [Plain Paper]:
Prints on paper loaded in a paper tray. The printer picks paper from the
paper tray that is loaded with the media size you selected in the
application software. When the tray is empty, the printer automatically
picks from another paper tray of the same media size in the order of
Upper, Middle and Lower.

® Auto [Transparency]:
Prints on transparency loaded in a transparency tray. The printer picks
transparency from the transparency tray that is loaded with the media
size you selected in the application software. When the tray is empty,
the printer automatically picks from another transparency tray of the
same media size in the order of Upper, Middle and Lower.

® Upper :
Prints on media loaded in the standard tray.

e Middlex**:
Prints on media loaded in the upper tray (optional feeder).

® | ower*!:
Prints on media loaded in the lower tray (optional feeder).

® MPT Plain Paper, MPT Transparency, MPT Label, MPT Coated
Paper, MPT Envelope, MPT Paper 2nd Side :
Prints on paper, transparency or label, etc. loaded in the Multi-purpose
tray. The printer will print on the selected media with optimal quality.

*1 |f the optional feeder has not been installed, the printer selects the
standard tray automatically.

© Copy Count
Determines how many copies of the document will be printed.

Note:

® The number of copies can also be determined using the application
software. However, it is recommended to set the number of copies using
one method, either from this driver or from the application software to
avoid printing problems.

O Orientation
Selects Portrait (vertical) or Landscape (horizontal).
Portrait Landscape

A A

81



82

Using the Printer

Advanced Tab

Two categories (Paper/Output and Document Options) for document settings are
available. To display the items of a category, click on that category.

m Paper/Output

2 Panazonic K2-P3410 Document Settings &
= _E'_j Paper/Output
|=] FPaper Size: <Lefter:
.-_f] Orientation: <Paortraits
2] Paper Source: <Auta [Plain Paper]s
[} Copy Count: <1 Copy
= .j"!';:‘g Document Options
D&j Print Stole: < Color Graphics:
J Print Quality: < Standard [E00 dpi)s

[#] Dithering Mode: <D efault: -
J Ll_‘

LChange 'Paper Size' Setting

=] A4
(=] Ervelope #10

=] Leaal

| k. | Cancel

As for the features of each items (Paper Size, Orientation, Paper Source, Copy
Count), refer to Page Setup Tab ([ P. 80).

Clicking on an item displays its selections in the lower box. Click your desired
selection, then click [OK |.
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m Document Options

& Panasonic KX-P8410 Default Document Properties
Page Setup Advanced
[ Copy Count: <1 Copy: ﬂ
= [,'“E# Diocument Options
(1) L}Ej Print Style: <Color Graphics:
(2] J Print Quality: <Standard [E00 dpi):
(3) [#] Dithering Mode: <Default:
(4] |_| COutput Order: <Face Do
(5} Q% Hyper-Tetra Adjustment... <ze Hyper-Tetra Adjustment:
(6} a Uze Gray Scale Density
(7] ﬂ Print az a Mirror image: <0Ff
(8 ty' Metafile Spooling: <Enabled: =
4| »
] | Cancel
@ Print Style

Click on Print Style to display its selections in the lower box, and
select a type which is the closest to your document to ensure optimal
print quality.
® Black Text:
Prints the document in black and white. Select this for black and white
text. This is the fastest printing option.
® Gray Scale:
Prints the document in black and white. Select this for monochrome
halftone images.
® Color Graphics: (default)
Prints the document in color. Select this for computer graphics, color
text or spreadsheets with color graphics.
(Small text can be printed more clearly than when printed in
Presentation.)
® Color Photo:
Prints the document in color. Select this for photo images such as a
photo from a CD.
® Presentation:
Prints the document in color. Select this for presentation printing.
(Presentation provides a clearer tone than Color Graphics.)
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@ Print Quality
Click on Print Quality to display its selections in the lower box, and select
a print quality. Fast (300 dpi), Standard (600 dpi) or High quality (1200
dpi) can be selected. A higher resolution provides better print quality.
However, the throughput speed is diminished.

When Presentation is selected in the Print style, print quality cannot be
selected and 300 dpi is automatically assigned.

©® Dithering Mode
Color Graphics and Color Photo are print styles that simulate shades of
color by changing the dot patterns. You can select a dot pattern using
Default**, Dither A, or Dither B.
This selection is effective only when Color Graphics or Color Photo is
selected.

*1 Most appropriate Dithering mode may be automatically selected
according to the print style, print quality and printer memory you have
selected.

Notes:

® When Color Graphics is selected in the Print Style, Dithering mode is
available for all print quality selections.

® When Color Photo is selected in the Print Style, Dithering mode is available
only for 600 dpi and 1200 dpi print quality selections.

@ /f the error message “Memory Overflow” appears when Default or Dither B is
selected, change the selection to Dither A. With Dither A selected, memory
overflow may not occur.
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O Output Order
Specifies whether the document exits face up or face down into the output
tray. This selection is not effective when the multi-purpose tray (MPT Plain
Paper, MPT Transparency, etc.) is selected in the Paper Source
(O P.81). When the multi-purpose tray is selected, Face up is selected
automatically.

@ Hyper-Tetra Adjustment...
Adjusts the brightness, contrast, hue, saturation, or red, green, blue, or
cyan, magenta, yellow, black of the image. For the adjustment, refer to
Using the Hyper-Tetra Adjustment ( [0 P. 97). This function is effective
only when the Color Graphics, Color Photo or Presentation print style is
selected.

@ Gray Scale Density Adjustment...

Adjusts the density of the gray scale image. This function is effective only
when the Gray Scale print style ( [ P. 83 Advanced Tab) is selected.
For the adjustment, refer to Using the Density Adjustment (0 P. 102).

@ Print as a Mirror image
Clicking on Print as a Mirror image allows you to print a mirror image of
the document.

© Metafile Spooling
Specifies the format in which the printing information is stored on your disk
for printing. Generally, metafile spooling set to Enabled frees up your
program faster than Disabled.
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® When Panasonic KX-P8410 Document Settings is
selected

é Panasonic KX-P8410 Default Document Properties EHE

FPage Setup Advanced l

= _E_ﬁ Faper/Output
|=] Paper Size: <Letters
:_\1 Orientation: <Paortraits
2] Paper Saurce: <Auta [Flain Paper]s

[# Copp Count: <1 Copy:
—|- s Document Options
ij Prit Style: <Caolor Graphics:
J Prirt Quality: <Standard [EO00 dpi):

[#] Dithering Mode: <Default: -
d LH

FPanazonic F=-FE410 Document 5 ettings

o |

P @ About KXPB410 Printer Diiver... |

k. | Cancel

@ Undo Changed Option

Returns the Page Setup and Advanced tab’s settings to the previous
settings.

@ About KX-P8410 Printer Driver...

Displays the window that contains the program version and copyright
information.
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Displaying the Panasonic KX-P8410 Properties Window

(for Windows NT 4.0)

1 Click , select Settings, then click Printers.

The Printers window is displayed.

2 Click the Panasonic K X-P8410 icon.

3 Click the File menu, then click Properties.
The Panasonic KX-P8410 Properties window is displayed.

‘l Panazonic KX-P8410 Properties

General l Partz ] Scheduling] Sharing] Securit_l,l] Drevice Settings]

=

24 Panasonic Kx-PE410

LCornment:
Locatian: |
Driver | Panasonic Kx-P8410 *]  MNewDriver...
Separatar Page... | Frint Proceszor. . | Frint Tezt Page |

| aF. | Cancel

4 Click a tab to view the features.

Ports Tab (O P. 88)
Sharing Tab (O P. 92)
Device Settings Tab (0 P. 95)

For the features of the other tabs, refer to the Help menu in the
Windows NT 4.0.
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Ports Tab (SCSI port)

Note:
® This option is available only for Windows NT 4.0.

&% Panasonic KX-P8410 Properties

Gereral FPorts lScheduIing] Sharing] Seu:urit_l,ll Device Settings]

=

Lo Panazonic F-PE410

Print to the following port(z]. Documents will print to the first free

checked port,
Puort D'ezcription Printer -

O— vINit Local Paort FPanazonic Fx-PE4. .

LPTZ Local Port

LPTZ Lacal Part

CO1: Lacal Part

COr2: Lacal Part

COm3: Local Port

kA A- | real Bt ﬂ
O ——— AddPar.. Delete Port Configure Port. .. |

[v Enable bidirectional suppart
[ Enable printer pooling

k. | Cancel

@ Checked port

Documents will print to the checked port.

@ Add Port... button
Adds a new port (I P. 89 Installing the SCSI port).
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m Installing the SCSI port

Notes:
® |t [s recommended that you do not connect the printer directly to the file server.
Otherwise the printer and server performance may be diminished.
® When printing through the SCSI port, the access speed between other
connected SCSI devices get slower.
® To connect the KX-P8410 to your SCSI port, a SCSI driver and ASPI Manager
need to be installed. Refer to your SCSI board manual.

q Click|Add Port...|.

The Printer Ports window appears.

Printer Ports | 7]

Axaillable Printer Portz:

Lexmark TCPAAP Metwark, Part
Local Part

MHew Monitar....

M ew Part... Cancel

2 Click |[New Monitor...] .

The Installing Print Monitor window appears.

Inztalling Print Monitor

] The file ‘maonitor.inf* on [Unknown] iz needed. k.

Cancel

Type the path where the file iz located, and then click
k.

Skip File

Copy files from:

|ﬁ ﬂ Browse. ..

Ik ek
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3 Insert the KX-P8410 CD-ROM into the CD-ROM drive.

4 clck[Browse..]

5 Click [Cancel].

The Locate File window is displayed.

Note:
® The SCSI port cannot be installed through the Monitor.inf file when copied to a
directory with long file name.

6 Select CD-ROM drive.

7 Open Winnt40, Disk2, then select Monitor.inf file.

Click :

8 Click [OK] .

The Printer Ports window is displayed.
Printer Ports | 2]

Axailable Printer Portz:

kx-PE410 on SCSI

Mew Port.... Cancel
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Click [ New Port...] .

The Port Name window is displayed.
Port Hame

Enter a port name: k.

| Cancel

Help

dilf].

Type the port name (for example; KXP8410GDI), then click
:

The Printer Ports window is displayed.

Click |

&% Panasonic KX-P8410 Properties

General Ports lScheduIing] Sharing] Security] Device Settings]

=

S Panaszonic KxX-PE410

Print to the following port[z]. Documents will prnt ko the first free

checked port.
Port Description Frinter =
v| KxPE41 0G0 Fa-P8410 on SC5I
LPT1: Lacal Part Panazonic F=-PE4...
LPTZ Loczal Part
LPT3: Local Port
COk1: Local Port
COk 2 Lacal Part
COb3: Local Port i
COM4: Local Part hd
Add Port.. Delete Port Configure Port... |

[+ Enable bidirectional suppart
[ Enable printer pooling

] Cancel
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Sharing Tab

&% Panasonic KX-P8410 Properties

General] Puartz ] Scheduling  Sharing l Seu:urit_l,ll Device Settings]

Ly

L Panasonic Kx-PE410

" Mot Shared

( S

Share Mame: |F'anasu:uni

'ou may install alternate drivers so that uzers on the following systems can
download them automatically when they connect.

@O Alemnate Drivers:

YWindows 95 -
Windows MT 4.0 x86 [Installed]

Windows NT 4.0 MIPS

Windows MT 4.0 Alpha

windows MT 4.0 PPC
“Windows NT 2.5 or 351 #85 |

To modify the permizzions on the printer, go ko the Security tab.

] | Cancel

@ Shared
To share the printer over the network.
For the setup operation, refer to Sharing the printer with a client
computer (U P. 93).

@ Alternate Drivers

To install an alternate driver.
For the installation, refer to Installing an alternate driver (L P. 93).
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m Sharing the printer with a client computer

1 Click Shared.

2 Type the printer name (for example: KX-P8410).

Note:
® /f the shared printer is used through Windows 95, the printer name must not
exceed 12 characters.

3 cilick[oK].

m Installing an alternate driver (for example: Windows 95)

1 Select Windows 95, then click [OK].

The Insert Disk window is displayed.

Insert Disk

Pleasze ingert the loppy digk labeled wWindows 95" into drive A; and then click Ok,

ouw can also click OF, if pou want files to be copied from an alternate location, such az a network, zerver or a compact

disc.
Cahicel

D Click [OK].

The Printer Drivers for Windows 95 window is displayed.

Prnter Dnvers for Windows 95

] The file "*.inf* on Windows 95 iz needed. k.

Cancel

Type the path where the file iz located, and then click
k.

Skip File

Copy files from:

E ﬂ Browse. ..

i E ek

3 Click[Browse...] .
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94

/4 Click [Cancel].

The Locate File window is displayed.

5 Insert the supplied KX-P8410 CD-ROM into the CD-ROM drive.
Select CD-ROM drive.

7 Open Win95, Disk2, then select KXP8410.inf file. Click .

The Printer Drivers for Window 95 window is displayed.

Printer Driverz for Windows 95

] The file *=.inf* on Windows 95 s needed. 0k,

Cancel

Twpe the path where the file iz located, and then click
0k.

Skip File

Copy files from;

B R

- | Browse...

8 Click [OK]].
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Device Settings Tab

4% Panasonic KX-P8410 Properties

General] Forts ] Scheduling] Sharing] Securty Device Settings l

~i# Panazanic Kx-PE410 Device Settings

=< Option
o—— S Frinter memony: < 8 MB:
0— S IJze printer memonye to make print perfo

e—— = ;‘] Formn To Tray Assignment

=] Upper: <Letter:
=] Middle: <Letter:
=] Lower: <Letter:
=] Multi-Purpose Tray: <Letter:

1 2

Change 'Printer memony' Setting

w@ ELE =]

s | Cancel

@ Printer memory
Selects the amount of memory installed in the printer. If the amount of
memory in the printer does not match this setting, a MEMORY
OVERFLOW message might be displayed. To determine how much
memory is installed in the printer, print out the Test page (O P. 39).
As the printer memory increases, printing throughput improves. If the total
printer memory is set more than 32 MB, Printer memory usage option (@)
becomes effective.
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@ Printer memory usage

Determines how the printer memory is used, either for better print

performance or for better print quality. This selection is effective only when

the Gray Scale or the Color Photo print style is selected and the

Standard (600 dpi) is selected.

More than 32 MB is required on the printer to select this option.
® Use printer memory to make print performance better

Sends the data to the printer with the standard level of compression to
improve throughput.

® Use printer memory to make print quality better

Sends the data to the printer with a lower level of compression or

without compression to improve the print quality. However, the

throughput will be diminished.

©® Form To Tray Assignment
Server can assign and display the media loaded in the printer. Client can
view the media assignment. This assignment does not affect any print job.

m When Panasonic KX-P8410 Device Settings is

selected

‘ Panaszonic KX-P8410 Properties

HE

General] Parts ] Scheduling] Sharing] Secury  Device Settings l

—-< Option

S
St

G

J

c Printer merary: < 3 kB>

= :] Form To Tray Azsignment
|=] Upper: <Letter:
=] Middle: <Letter:
|=] Lower: <Letters
=] Multi-Purpoze Tray: <Letter:

|lze printer memorny to make print perfo

Fanazonic Kx-P3410 Device Settings

O (D About KXPB410 Printer Driver... |

@ Undo Changed Option
Returns the Device Settings tab’s setting to the previous setting.

(]S | Cancel

@ About KX-P8410 Printer Driver...

Displays the window that contains the program version and copyright

information.
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Using the Hyper-Tetra Adjustment

You can adjust the color of your output using the Hyper-Tetra Adjustment window.

Displaying the Hyper-Tetra Adjustment Window

mFor Windows 95/ 3.1

1 Click on the Use Hyper-Tetra Adjustment check box in the
Option tab (0O P. 74).

The Adjustment... button becomes effective.

2 Click | Adjustment...|.
The Hyper-Tetra Adjustment window is displayed.

mFor Windows NT 4.0

1 Click on Hyper-Tetra Adjustment ... in the Advanced tab
(0 P.82).

The Hyper-Tetra Adjustment... button appears in the lower box.

2 Click |[Hyper-Tetra Adjustment... |.

The Hyper-Tetra Adjustment window is displayed.
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Color Adjustment

To adjust the brightness, contrast, hue or saturation of color, select Color
Adjustment in the Hyper-Tetra Adjustment window.

Preview box

i+ Color Adjustment

" Color Balance

(" Color CMYEK Adjustment

o— Brightness
4

A ]
e—guntlast
Al ]
G,— Hue
T B B—
e—iaturatinn
P R E— e T ;
Cancel | About | Reset
(5] (6] (7] (8]

@ Brightness
Changes the brightness of an image. A higher brightness setting provides a
lighter image and a lower brightness setting provides a darker image.

@ Contrast

Adjusts the range between the darkest and the lightest shades in the
image.

© Hue

Changes the aspect of color.

O Saturation
Changes the brightness and vividness of color. Lower saturation settings
provide dull and dark images, and higher saturation settings provide bright
and vivid images.

The range of each option (@ to @) is from 0 to 255.

© OK button
Makes a selection effective and closes the window.

@ Cancel button
Cancels a selection and closes the window.
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@ About button

Displays the window that contains the program version and copyright
information.

© Reset button

Resets the current setting(s) made in this window to the default setting(s).

Adjust the color by performing the following steps.

1 Drag each slider left or right or click <« or p, or type the
numerical value.

@ You can see the result of the adjustment in the Preview box.

® To reset the setting, click .

2 Click [OK |to make the setting(s) effective.

99



100

Using the Printer

Color Balance

To adjust the level of red, green or blue, select Color Balance in the Hyper-Tetra

Adjustment window. The following options appear.
J gop bp Preview box

Hyper Tetra Adjusmen

" Color Adjustment

" Color CMYE. Adjustment

©Q@— Red

N — —— T
@ Green

N B ]
e—ﬁlue

JEN I —— ]

(114 | Cancel | Ahout | Reszet

@ Red

Lightens or darkens red. A darker level setting provides a stronger cyan.

@ Green

Lightens or darkens green. A darker level setting provides a stronger
magenta.

© Blue

Lightens or darkens blue. A darker level setting provides a stronger yellow.

The setting range of each option is from 0 to 255.

Adjust the color by performing the following steps.

1 Drag each slider left or right or click <« or », or type the
numerical value.

il _ 2

Darker <«———» Lighter

@ You can see the result of the adjustment in the Preview box.

® To reset the settings, click .

2 Click [OK Jto make the setting(s) effective.
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Color CMYK Adjustment

To adjust the cyan, magenta, yellow or black color, select Color CMYK Adjustment
in the Hyper-Tetra Adjustment window.

Preview box

Hyper-Tetra Adjustment

" Color Adjustment

" Color Balance

i+ iColor CMYK Adjustment

@ Cean
A

Magenta
© e

e)—‘t'ellu!
N -

O —— Black
R R

(1] 4 | Cancel | About | Reset

@ Cyan
Adjusts the Cyan density of the image.

@ Magenta
Adjusts the Magenta density of the image.

© Yellow
Adjusts the Yellow density of the image.

O Black
Adjusts the Black density of the image.

The setting range of each option is from 0 to 255

Adjust the color by performing the following steps.

1 Drag each slider left or right or click < or », or type the
numerical value.

@ You can see the result of the adjustment in the Preview box.

e To reset the settings, click .

D Click to make the setting(s) effective.
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Using the Density Adjustment

You can adjust the grayscale density of your output using the Density adjustment
window.

Displaying the Density Adjustment Window
m For Windows 95/3.1

1 Click on the Use density adjustment check box in the Option
tab (O P. 74).

The Density... button is enabled.

2 Click .

The Density Adjustment window is displayed.

m For Windows NT 4.0

1 Click on Gray Scale Density Adjustment... in the Advanced tab
(O P.82).

The Gray Scale Density Adjustment... button appears in the lower box.

2 Click| Gray Scale Density Adjustment...]|.

The Density Adjustment window is displayed.
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Preview box

L1 (2] 3]

© OK button
Makes the adjustment effective and closes the window.

@ Cancel button
Cancels the adjustment and closes the window.

€ Restore Default button
Restores the default image.

Adjust the gray scale by performing the following steps.

1 Drag the slider left/right, or click </p».
Rl - 2

Lighter <«———— Darker

e You can see the result of the adjustment in the Preview box.

2 Click to make the adjustment effective.
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Two-Sided Printing Using Microsoft Word 95

Single sided documents can be printed on both sides of the paper using an
application software, such as Microsoft® Word word processor for Windows 95. The
instructions described here are only for Microsoft Word for Windows 95.

1 Open document in Word for Windows 95.

2 From the File menu, click Print... .

The Print window is displayed.
Printer box

B
Frinker
|,,6j FPanazonic Kx-F8410 ﬂ Properties

Marmne:

Statusz: |dle

Type: FPanazonic Kx-P8410

Where: [ Print to file
Comment;

Copies

FPage range
O Mumber of copies; El:

1
" Curent page "
" Pages: W Collate
Enter page numberz and/or page ranges

zeparated by commasz. For example, 1,3,5-12

Piint what:  [Document =] Fint  EEE——
(] | Cloze | ‘ Optiohz. .. |

Print menu box

3 Make sure that Panasonic KX-P8410 is selected in the Printer

box, then click .

The Panasonic KX-P8410 window is displayed.

4 Select Face up in the Output order box, then click .

The Panasonic KX-P8410 window is closed.

Select Odd pages from the Print menu box, then click|OK|. The
Print window is closed and odd pages will be printed face up.

104



Using the Printer

Print

Place the printed pages in the multi-purpose tray with the pages
face down and top first.

7 From the File menu, click Print... .

The Print window is displayed.

7] ]

Printer
Mame: | i Panasoric Kx-PE410 ] Eroperties

Statuz: |dle
Type: Fanazonic Kx-P8410
Wwhere: ™ Pritt to file

Comment;

Page range Copies

oA Mumber of copies: ,

" Curent page "
" Pages: | ¥ Callate
Enter page numberz and/or page ranges

zeparated by commaz. For example, 1,3.5-12

Piint what:  [Document =] Fint  [EYEEEE———
QF. | Cloze | Dptions... |

Print menu box

8 Click Properties |.

The Panasonic KX-P8410 window is displayed.

9 Select MPT Paper 2nd Side from the Paper source pop-up

menu, then click .

The Panasonic KX-P8410 window is closed.

10 Select Even Pages from the Print menu box, then click.

The Print window is closed and even pages will be printed on the back side of
the paper.
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Periodic cleaning of the printer is recommended. The frequency of cleaning is
dependent upon the environment in which the printer is used. You should clean the
printer:

® At least once a month.

® \When the printer experiences frequent media jams.

® \When print quality has deteriorated.

m External

1 Turn the power OFF.

Clean all the covers with a soft cloth. Use any mild commercial
cleaner.

Caution:
® Do not use benzine, thinner, aerosol cleaners, or any abrasive powder.

m Internal
When using isopropyl alcohol with a lint-free cloth, make sure that the alcohol is at
least 90% pure, obtainable from your local pharmacy. (Do not use rubbing alcohol; it

can damage the printer.)

Cleaning the paper-pick rollers

l Slide the media tray out (you do not have to remove it) to allow
access to the paper-pick rollers.

2 Open the left side door.

(7777777

3 Use the green handles to
pull out the paper feeder.
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Gently rotate the paper-pick rollers 180° (the paper-pick rollers

are D-shaped) and wipe them with a lint-free cloth that has been
moistened with isopropyl alcohol.

6 Slide the media tray back into place.

Note:

® /f you have a 2nd Cassette Feeder,
you may also need to clean the rollers
for the middle and lower media trays,

which are accessed through the lower
left side door.

Cleaning the home sensor

If your printer panel displays Printer Error 30, clean the home sensor inside the
printer.

1 Open the printer’s front door.
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2 Remove the imaging unit:

@ Loosen the two thumbscrews by turning them
counterclockwise.

@ Turn the lower green lever 180° counterclockwise.

© Grasping the front green handle, slide the imaging unit out until
it catches.

@ Lift up the left green handle. Pull the imaging unit out of the
printer and cover it to protect it from light exposure.

Green surface

Black belt

Important:
® Do not touch the green surface (the right side) or the black belt (the underside).
Finger prints may affect the print quality.

Safety Caution:
® The imaging unit weighs approximately 6.5 kg {14.3 Ibs.}. Always use the
handles when lifting it.

Cautions:
® Do not expose the imaging unit to artificial light for more than 45 seconds; or
you may damage the unit. Never expose it to direct sunlight.
® Do not leave the printer’s front door open for an extended period of time (for
example, several hours).
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3 Use a dry, lint-free cloth to wipe the slot of the sensor.

Sensor

Reinsert the imaging unit into the printer, holding it by its green
handles.

Match the arrow on the right side of the imaging unit with the arrow on the
printer, and slightly push the imaging unit into the printer. Then release the left
handle and push the unit in until it stops.

@ Turn the lower green lever clockwise 180° to insert the unit
completely and to lock it.

@ Tighten the two green thumbscrews by turning them clockwise.

© Close the front door.

\

%‘

\

\\
/
o
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User Replaceable Components

When the printer panel indicates that a supply needs to be replaced, make sure that
you have replacement supplies on hand. The printer may continue to print until the
supply is completely used up; then it stops until you replace the indicated supply.

110

Printer component

Printer panel message

Average life

Color imaging unit **

Imaging Unit wearing out

Change the Imaging unit soon.

Monochrome
57,000 pages
or

Color
14,250 pages

Imaging Unit
Worn out

Change the Imaging unit now.

Monochrome
60,000 pages
or

Color
15,000 pages

*1 These figures are based on an average of 5% coverage of the printable area and
standard density for any one color (refer to Example A : Monochrome 5%
coverage). 4 colors (Cyan, Magenta, Yellow and Black) are used for full color print.
The replacement frequency will vary depending on the complexity of the prints and
the coverage of each color and print density.

Example B is an example of full color print. The percentage of coverage for each

color is as follows.

Cyan : 40%, Magenta : 22%, Yellow : 35%, Black : 20%

If you continuously print this page, the average life of the Color Imaging Unit will be
shortened to about 2,500 pages.

Example A

Feature:

Printer Specification
Printing Method:

al fo

Paper Quiput:

512KB

Contact Iage Seosor

8.18"(208mm)
Letter,Ad Legal,
20 Sheet

5 PPM

Scanner /I Driver: TWAIN

Other Specification
Opercing Enviromens: 10 o 325°C |50 10 905" T

Storage Envitoment 010 35C {32 10 95 F)

Feature:

Text Bridge . Card Scan

Personal Image Editing System
model No. XX-XXXX

Congratulations on your purchuse of the XX-XXXX the three-in-one solution (o today’s office

needs. This amasing litle desklop cril e be used a5 o
adBlectro-Pholagraphy
(A4 size papergext mode,S% image area)

p o 1008
a(up 0 5O Sheet) [75g/m(2010x)]

300dpi X600dpi , 3000dpi > HH0dpi

Card(Manusl Fecd)

Congratulations cn your purchase of the XX-XXXX ,the three-in-one solution to today’s office

¢ lirle deskiop unit can he used as a :

Printer Scanner Copier.

of paper{75g/m(201bs.)]

ning Width

20 0 80%RH
20 10 80%RH

Priner.

nner,Copier.

Example B
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Printer component

Printer panel message

Average life

Toner cartridges ** *2

Low <Color> Toner

Change the color toner cartridge soon.

<Color> Toner
Empty

Change the color toner cartridge now.

10,000 pages
(CMY)

12,000 pages
(Black)

Fuser unit **
(Oil supply roll
installed)

Fuser Unit wearing out

Oil Roll wearing out

Change the Fuser unit soon.

Display
alternately

28,500 pages

Fuser Unit and Oil Roll
Worn out

Change the Fuser unit now.

31,000 pages

Oil Roll wearing out

Change the Oil supply roll soo

>

15,000 pages

QOil Roll
Worn out

Change the Oil supply roll now.

15,500 pages

Transfer unit

ey

Transfer wearing out

Change the Transfer unit soon.

80,000 pages

*1 Refer to ** on page 110.

*2 The starter cartridges that are shipped with the printer have an average life of

approximately 3,000 pages, based on an average of 5% coverage.

*3 Specialty media (Transparencies, coated paper, etc.) will result in shortening the

life expectancy of each consumable. When replacing the fuser unit, replace the oll

supply roll as well. Do not insert the used oil supply roll into the new fuser
unit; it may damage the new fuser unit.

Note:

If you print with high density when “Low <Color> Toner” is displayed, you may get

faded printout before “<Color> Toner Empty” is displayed.
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Clearing a Jam

mClearing a media jam

If the printer has frequent media jams, make sure that you follow these guidelines:

® Always use high-quality laser paper and transparencies. Refer to pages 166 and
167.

® Make sure that you load specialty media only in the multi-purpose tray and that you
set the media thickness switch to the correct setting for the media used.

If a media jam occurs, the printer panel reports Jam at <Location>. The <Locations>
are the various sensors throughout the paper path, listed as A through E.

The following illustration shows the locations of the sensors that report media jams
(A through E).

Jam at MPT Jam at B Jam at C
(O P.123) \ (O P.115) (0 P.116-119) | Jam atE
(O P.122)
Jam at A
(0 P.113-114) | TS=emsmemememamee Jam at D
' (O P. 120 - 121)

2nd cassette feeder (option)
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mJam at A

1A © Open the left side door corresponding to the selected media
tray.

® Remove the jammed media.

© Close the left side door.

0 ORO

@ Remove the media tray.

0]

©® Reinsert the media tray.

O Open and close the front door to clear the error message from
the LCD.
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(2nd cassette feeder)

(2]

© Close the lower left side door.
0 ORI

© Remove the selected media tray (middle or lower media tray).

©® Reinsert the media tray.

@O Open and close the front door to clear the error message from
the LCD.
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mJam at B

1 Open the left side door.

({7 [[T

4 Reinsert the paper feeder and close the left side door.
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mJam at C

l Remove the fuser:

© Open the printer front door.

@ Turn the small green thumbscrew counterclockwise to unlock
the fuser.

Safety Caution:
® The fuser is hot; to avoid personal injury, turn off the printer and wait 10
minutes (after opening the front door) for the fuser to cool before
touching it.

©® Holding the green tab on the right, slide the fuser out until the
safety catch stops it.

O Press the green lever on the left to release the safety catch.

CAUTION:
HOT SURFACE INSIDE
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2 @ Hold the fuser as shown below, and slide it out of the printer.
Safety Caution:
® The fuser unit weighs approximately 3.1 kg {6.8 Ibs.}. Take care when handling

it.

@ Close the front door.

3 Remove the oil supply roll:

@ Press out on tabs to unlock the oil supply roll.

@® Remove the oil supply roll out of the fuser.

Note:
® |f the paper is not jammed in the fuser unit, perform the following.
© Repeat steps 1 to 4 of Jam B on page 115.
@ Skip step 4 and go to step 5.
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4 @ Turn the fuser’s large green knob clockwise.

® Remove the jammed media.

5 © Replace the oil supply roll into the fuser.

@ Press down firmly on the oil supply roll to snap both sides into
place.

Oiled cloth

Note:
® /f the oiled cloth is loose, rotate the gear (A) clockwise until it is tight.
Do not touch the oiled cloth.

Caution:
® /f the oil supply roll is not installed correctly, print quality will be diminished.
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6 © Open the front door.
@ Slide the fuser back into the printer.

7 © Turn the small green thumbscrew clockwise to lock the fuser.

@ Close the front door.
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mJam at D

Safety Caution:
® The fuser is hot. To avoid personal injury, turn off the printer and wait 10
minutes (after opening the front door) for the fuser to cool before touching it.

Note:
® First check the exit opening for media that has jammed and folded like an
accordion. It is especially difficult to see if the media is transparency film.

lA (Printing face down)
© Open the front door.

@ Pull open the access door (above the plastic output tray); see
if the media is visible.

® Turn the large green knob on the fuser counterclockwise.

O Remove the media from inside the access door.
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Caution:
e® |f the fuser knob will not turn, do not force it, or you may damage the fuser.

Instead, follow these steps:

a) Unlock the fuser by turning the small green thumbscrew counterclockwise.
b) Pull the fuser out. The media will probably tear.

¢) Remove the oil supply roll.

d) Turn the fuser’s large green knob to release the jammed media.

e) Remove the jammed media from the fuser and the printer.

Safety Caution:
® The fuser is hot; to avoid personal injury, turn off the printer and wait 10
minutes for the fuser to cool before touching it.

@ Close the front door.

18 (Printing face up)
@ Open the front door and the right side door.

@ Turn the fuser’s large green knob counterclockwise to release
the jammed media.

©® Remove the jammed media from the right side of the printer.

O Close the front door and the right side door.
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mJam at E

1 Remove the jammed media from the output tray.

0 ORU

Pull open the access door (above the plastic output tray) and
remove the media.

2 Open and close the front door to clear the error message from the
LCD.
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mJam at MPT (Multi-purpose tray)

1 Remove the jammed media from the multi-purpose tray.

2 Open and close the front door to clear the error message from the
LCD.
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Troubleshooting

Trouble

Possible Cause

Corrective Action

READY indicator is
blinking.

The printer is receiving,
processing or printing
job.

Wait for the job to be
completed or cancel the
job.

You have entered the
Menu mode in the printer
panel.

Exit the Menu mode by
pressing the MENU/EXIT
button.

READY indicator is off.

The printer is not ready,
is disabled, or has
detected an error.

Read the printer panel
message to determine
the printer status.

ERROR indicator is on.

Error occurred that is not
user-correctable.

Turn the printer off and
back on again. If the
indicator is still on, the
printer requires service.

ERROR indicator is
blinking.

The printer has stopped
because it detected a
user-correctable error
such as an open door or
a media jam.

Correct the condition
displayed on the printer
panel (e.g., close the
door or clear the media
jam).

On the Maintenance
Page, a single color is
not uniform or many
vertical streaks (both
light and dark) of slightly
different density and
non-uniform color.

The toner is almost
depleted.

Replace the color toner
cartridge.

On the Maintenance
Page, half tone area has
areas of weak color.

Paper doesn’t match the
environmental conditions,
or it has too much
moisture.

Try fresh paper, or
another type of paper.

Store media in the
original, dust-free
package in the same
environmental conditions
as the printer.
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Trouble

Possible Cause

Corrective Action

A single color appears
faded.

The color density is set
incorrectly in the printer
panel.

Check the density setting
by printing the Color
Calibration Page in the
Color Calibration menu
from the printer panel.
Compare the settings
with the color density
samples on the Color
Calibration Card and, if
necessary, adjust the
density from the printer
panel. Refer to Setting
the Color Density on
page 56.

The toner is almost
depleted.

Replace the color toner
cartridge soon
(depending on the
complexity of your prints,
you can continue to print
up to 100 more pages).

On the Maintenance
Page, a single color has
a sharp, dark or light
vertical streak.

The toner cartridge is
almost depleted and is
not properly applying
toner.

Replace the color toner
cartridge.

Small white spots
appear on OHP
transparency.

OHP transparency has
dust on its surface.

Remove dust or stain
from OHP transparency.
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Trouble

Possible Cause

Corrective Action

On the Maintenance
Page, a single color
shows a light, repeating
horizontal line.

The roller in the toner
cartridge has a slight
impression after a long
period of storage.

Run 20-30 prints. The
impression will disappear
with continued time and
use.

Prints are missing fine-
line detail.

The imaging unit has
reached the end of its
useful life.

Replace the imaging unit.

Dark color spots and
dark or light streaks
appear in all colors.

The imaging unit has
reached the end of its
useful life.

Replace the imaging unit.

On the Maintenance
Page, straight, thin light
vertical line in colors.

The photosensitive belt
inside the imaging unit is
scratched.

Replace the imaging unit.

On the Maintenance
Page, each color
“bleeds” into the color
band.

The imaging unit’s
internal waste toner box
is full.

Replace the imaging unit.
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Trouble

Possible Cause

Corrective Action

On the Maintenance
Page, a single white spot
appears in
approximately the same
vertical place on the

page.

The imaging unit is
damaged.

Replace the imaging unit.

On the Maintenance
Page, large light spot(s)
appear randomly.

Fingerprint(s) on the
underside belt or
photosensitive belt
(inside) of the imaging
unit.

Print several pages until
the spots fade.

On the Maintenance
Page, one or more dark
vertical lines appear on
the print in all colors.

The imaging unit is
scratched.

Replace the imaging unit;

make sure that the old

imaging unit is not

exposed to light for more

than 45 seconds.

If a new imaging unit

does not correct the

problem:

® Put the old imaging
unit back into the
printer.

® Repack the new
imaging unit.

The fuser is damaged.

Replace the fuser.
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Trouble

Possible Cause

Corrective Action

A piece of the printed
image is missing and
reappears out of place,
approximately 129 mm
(5") down the page.

The fuser’s internal roller
is not being consistently
oiled.

or
The fuser’s internal roller
is contaminated with
toner particles.

Print 5-10 pages of blank
pages to clean the roller.
If you still see the
problem:
® Replace the oil supply
roll.
If you still see the
problem:
® Replace the fuser.

The surface of the
printed image appears to
have vertical scratches
(visible by holding the
print at an angle and
observing the “shine” of
the image).

At first, the scratches
appear only on the
printed image;
eventually, dark vertical
scratches appear on the
unprinted portion of the

page.

The fuser is near the end
of its useful life.

Replace the fuser
(depending on your
quality needs, you can
continue to print until the
dark vertical lines
appear).

Media frequently wraps
around the fuser.

The oil supply roll has
reached the end of its
useful life.

Replace the oil supply
roll.

Light vertical streaks
appear in all colors.

The main charge grid is
dirty.

Replace the imaging unit.




Care and Maintenance

Trouble

Possible Cause

Corrective Action

Dark and wavy vertical
streaks appear in all
colors.

The main charge grid is
dirty.

Replace the imaging unit.

The entire page prints in
black, including the
borders.

Bad electrical contact for
the main charge grid.

Reinsert the imaging unit
to correct the contact for
the main charge grid.

The main charge grid is
broken.

Replace the imaging unit.

Toner spots appear on
the back of the media.

The transfer unit is worn
out.

Replace the transfer unit.

The page prints in black
in the image area only.
(The borders are clear.)

Either the image
processor board or
engine control board is
not functioning properly.

Turn the printer off and
back on again. If the
problem persists, call for
service on your printer.
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Trouble

Possible Cause

Corrective Action

The page is completely
blank.

The problem could be

with one of the following:

® Engine control board.

® Developer voltage.

® [ aser scanning unit
mirror.

Turn the printer off and
back on again. If the
problem persists, call for
service on your printer.

Service Error is
displayed on the LCD.

An error occurred that is
not user-correctable.

Turn the printer off and
back on again. If the error
persists, call for service.
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m|f you can’'t make a print

Trouble

Corrective Action

Printer not operating.

Make sure that you plugged in the printer and turned it on.

properly.

Make sure that you connected the interface cable(s)

More info to come for

these messages.

If the communication link between your computer and

the printer is working but the printer ejects a blank page
when printing from your application or through Windows,
make sure that the appropriate driver is installed and that
you have selected the printer correctly.

Trouble

Possible Cause

Corrective Action

The printer does
not print
correctly.

The computer is not
properly
communicating with
the printer.

Follow the procedure below and
disable the
bi-directional interface. (The Status

Display function becomes ineffective.)

Windows 95:

1. Click Start, select Settings, then
click Printers.

2. Click the Panasonic KX-P8410 icon.

3. Click the File menu, then click
Properties.

4. Click the Details tab and Spool
settings... .

5. Click Disable bi-directional

support for this printer, then click
OK.

Windows NT 4.0:

1.

N

6.

Click Start, select Settings, then
click Printers.

. Click the Panasonic K X-P8410 icon.
. Click the File menu, then click

Properties.

. Click the Ports tab.
. Click off the Enable bidirectional

support check box.
Click OK.

The setting for
printing is not
effective.

Some applications
may not allow you
to change the
settings through the
KX-P8410 printer
driver’s setting
window.

Change the application’s settings.
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m Media problems

Trouble

Corrective Action

Frequent paper-
picking errors.

Fan the paper or transparencies before installing them in
their respective trays; this is especially important for
transparencies because they tend to stick together.

Make sure that you have loaded paper in the paper tray
and transparencies in the transparency tray.

Make sure that the media is installed under the hooks at
the front of the media tray.

If printing on transparencies and your printer has a 2nd
Cassette Feeder, make sure that the transparency tray is
installed in the upper or middle tray slot.

Clean the paper-pick rollers
(O P. 106 for instructions).

Frequent media jams.

Make sure that you use a high-quality laser paper:
60-105 g/m? (16-28 Ibs.) paper in the media trays and
75-165 g/m? (20-44 Ibs.) paper in the multi-purpose tray.

If you are using media that is 105 g/m? (28 Ibs.), check if
the Face Down media output setting is selected in the
driver. If it is, change the setting to Face Up.

Use only recommended transparencies ( [J P. 167).
We cannot guarantee the results of other transparencies.

Make sure that the media is installed under the hooks at
the front of the media tray.

Do not overfill the media tray, as indicated by the red line
on the right side of the tray.

Clean the paper-pick rollers
(O P. 106 for instructions).

Make sure that the media thickness switch is set
correctly for the installed media ( 0 P. 29).

m Problems with image size and position

Trouble

Corrective Action

Off-set images.

Check your application for correct image sizing.

Cut-off images.

Check your application for image sizing.

Make sure that the correct size media is in the media
tray.
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m Print quality problems

Trouble

Corrective Action

Prints have dull, faded
colors.

Print the Color Calibration Page from the Color
Calibration menu in the printer panel. Check the density
settings for each color and compare them to the
examples on the Color Density Samples. Refer to Setting
the Color Density on page 56 for instructions on
comparing and setting color density.

Make sure that the imaging unit stays covered until
immediately before installing it in the printer. Exposure to
light can damage the imaging unit and will produce light
streaks or faded prints.

Make sure that the toner cartridges are installed correctly.

Make sure that you use a high-quality laser paper:
60-105 g/m? (16-28 Ibs.) paper in the media trays and
75-165 g/m? (20-44 Ibs.) paper in the multi-purpose tray.

Image is very faded or
pieces of the image
are missing; toner on
the page is loose.

When using the multi-purpose tray, make sure that you
have selected the correct media type in the driver or in
the Menu mode of the printer panel.

Streaks or spots

Most spots are caused by fingerprints or dust introduced
into the printer while installing the imaging unit or loading
media.

Make sure that the surface where you unpack the
imaging unit, paper, and transparencies is free of dust.
Keep supplies in a covered area or a closed box.

Make sure that the imaging unit stays covered until
immediately before installing it in the printer. Exposure to
light for more than 45 seconds can damage the imaging
unit.

Do not touch the right side or underside of the imaging
unit; fingerprints affect print quality.

Make sure that the paper or transparency film is clean.

Make sure that you handle the media on the outside
edges to avoid fingerprints.

To get rid of fingerprint spots, print a few prints.

The back of the
printed page appears
dirty.

Toner particles have contaminated the transfer roller.
This can happen if the printed image is larger than the
media (for example, when printing on envelopes). Run
10-20 prints to clean the transfer roller.

The print quality of a
transparency is poor.

There is a defect on the coated surface of the
transparency. Print on the other side.
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SCSI

If trouble occurs when printing using SCSI, confirm that the ASPI Manager is
installed. If the ASPI Manager is not installed, you must install it. It is assumed that
the Adaptec SCSI host adapter is installed.

m\Windows 3.1 users

1 Confirm that the SCSI host adapter is installed in your PC
correctly.

2 In CONFIG.SYS file, check the following setting.

DEVICE = ASPINDOS.SYS (n = 2, 4, 8 etc.)
If this setting does not exist in CONFIG.SYS, reinstall SCSI driver
using EZ-SCSI (refer to the SCSI host adapter users manual).

3 Confirm that the EZ-SCSI is installed in Windows 3.1. If Adaptec
EZ-SCSI program group does not exist, install SCSI driver using
EZ-SCSI (refer to SCSI host adapter users manual).

4 After finishing necessary procedure, restart PC and make sure
that the following message appears on your PC.

“ASPINDOS.SYS Installation successful”

5 Start Windows and confirm that the printer is recognized by PC
using SCSI utility in EZ-SCSI program group or Show
Configuration in KX-P8410 Utilities program group.

If the printer is not recognized, please recheck SCSI ID or
terminator settings.
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m\Windows 95 users

1 Confirm that the SCSI host adapter is installed in your PC
correctly.

2 Click[Start]and select Settings, then click Control Panel.
3 Double-click the System icon from the Control Panel.

4 Click Device Manager tab.

If the SCSI host adapter does not exist or displayed with the
exclamation mark !, SCSI driver is not installed correctly. Reinstall
the SCSI driver (refer to SCSI host adapter users manual).

5 If the SCSI driver is installed correctly, confirm that the printer is
recognized by the PC using Show SCSI utility in EZ-SCSI
program group or Show Configuration in KX-P8410 Utilities
program group.

If the printer is not recognized, please recheck the SCSI ID or
terminator settings.
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m\Windows NT 4.0 users

1

Confirm that the SCSI host adapter is installed in your PC
correctly.

Click Start and select Settings, then click Control Panel.

Double-click the SCSI Adaptersicon from the Control Panel.

If the SCSI host adapter does not exist, SCSI driver is not
installed correctly. Reinstall the SCSI driver (refer to SCSI host
adapter users manual).

If the SCSI driver is installed correctly, confirm that the printer is
recognized by PC using SCSI utility in EZ-SCSI program.

If the printer is not recognized, please recheck the SCSI ID or
terminator settings.
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Error Messages

Printer LCD Panel

Error Message

Possible Cause

Corrective Action

Jam at A
See front door label

A jam has occurred in
the media feed area.

Refer to page 113 to
clear the jam.

Jam at B
See front door label

A jam has occurred in
the media feed area.

Refer to page 115 to
clear the jam.

Jamat C
See front door label

A jam has occurred in
the fuser unit.

Refer to page 116 to
clear the jam.

Jam at D
See front door label

A jam has occurred
inside the access door
or the right side door.

Refer to page 120 to
clear the jam.

Jam at E A jam has occurred in Refer to page 122 to
See front door label the output area. clear the jam.
Jam at MPT A jam has occurred in Refer to page 123 to

See front door label

the multi-purpose tray.

clear the jam.

Front or Right door
Open

Front or right side door
is open.

Close the front or right
side door.

Left side door
Open

Left side door is open.

Close the left side door.

Lower Left side door
Open

Optional cassette side
door is open.

Close the optional
cassette side door.

Upper Left side door
Open

Standard cassette side
door is open.

Close the left side door.

Black Toner Cartridge
Not installed

Black toner cartridge is
not installed.

Install the black toner
cartridge.

Cyan Toner Cartridge
Not installed

Cyan toner cartridge is
not installed.

Install the cyan toner
cartridge.

Magenta Toner Cartridge

Not installed

Magenta toner
cartridge is not
installed.

Install the magenta
toner cartridge.

Yellow Toner Cartridge

Yellow toner cartridge

Install the yellow toner

Not installed is not installed. cartridge.

Imaging Unit Imaging unit is not Install the imaging unit.
Not installed installed.

Fuser Unit Fuser unit is not Install the fuser unit.
Not installed installed.

Paper feeder

Paper feeder is not

Install the paper feeder.

Not installed installed.

Oil Roll Oil supply roll is not Install the oil supply roll.
Not installed installed.

Imaging Unit Imaging unit is not Install the imaging unit
No tension installed correctly. correctly.

Charger Charger is not installed. | Install the charger.

Not installed
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Error Message

Possible Cause

Corrective Action

All Media Tray All media trays are Install a media tray with
missing or empty missing or empty. media in it.
Media Tray Media tray is missing or | Install the media tray
Empty empty with mediain it.
Upper Tray Media tray is empty. Install media in the
Empty upper media tray.
Middle Tray Middle tray is empty in Install media in the
Empty the 2nd cassette feeder | middle media tray.
option.
Lower Tray Lower tray is empty in Install media in the
Empty the 2nd cassette feeder | lower media tray.

option.

Multi-Purpose Tray
Empty

Multi-purpose tray is
empty.

Install media in the
multi-purpose tray.

Paper Tray
Empty

No media tray is
installed or media tray
is empty.

Install a media tray with
paper in it.

Transparency Tray
Empty

No media tray is
installed or media tray
is empty.

Install a media tray with
transparencies in it.

Output Tray
Full

Output tray is full.

Remove the printed
media from the output
tray.

SIMM Check Error

Controller Optional
SIMM check error.

Call for service.

SCSil error Communication cannot | Connect the SCSI cable
be established between | correctly.
the printer and your
computer.
Ethernet Card Printer Ethernet Card Install the Ethernet Card
Check Error I/F Error. correctly.
Imaging Unit Imaging unit is worn Replace the imaging
Worn out out. unit now.

Imaging Unit wearing out

Imaging unit is wearing
out.

Replace the imaging
unit soon.

Transfer wearing out

Second transfer roller is
wearing out.

Replace the transfer
roller soon.

Fuser Unit and Qil Roll
Worn out

Fuser is worn out.

Replace the fuser unit
now.

Fuser Unit wearing out

Fuser is wearing out.

Replace the fuser unit
soon.

Oil Roll
Worn out

Oil supply roll is worn
out.

Replace the oil supply
roll now.

Oil Roll wearing out

Oil supply roll is
wearing out.

Replace the oil supply
roll soon.

Black Toner
Empty

Black toner cartridge is
empty.

Replace the black toner
cartridge now.
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Error Message

Possible Cause

Corrective Action

Cyan Toner
Empty

Cyan toner cartridge is
empty.

Replace the cyan toner
cartridge now.

Magenta Toner
Empty

Magenta toner
cartridge is empty.

Replace the magenta
toner cartridge now.

Yellow Toner
Empty

Yellow toner cartridge
is empty.

Replace the yellow
toner cartridge now.

Low Black Toner

Black toner cartridge is
almost empty.

Replace the black toner
cartridge soon.

Low Cyan Toner

Cyan toner cartridge is
almost empty.

Replace the cyan toner
cartridge soon.

Low Magenta Toner

Magenta toner
cartridge is almost
empty.

Replace the magenta
toner cartridge soon.

Low Yellow Toner

Yellow toner cartridge
is almost empty.

Replace the yellow
toner cartridge soon.

Memory Overflow

There is not enough
memory in the printer.

Press CONTINUE
button on the panel or
wait for auto recovery
after 10 seconds. (only
when Auto Continue
setting is ON)

Perform the following

procedure.

1. Add memory.

2. Select a lower
resolution on the
Printer Driver.

3. Select Dither A on the
Printer Driver.

Too hot to print Label
Remove Label, Cancel job

The printer is too hot or
room temperature is
too high to print Labels.

Wait until the printer
cools down, or use in a
cooler place [below
32.5°C (90.5°F)].

139



140

Care and Maintenance

Printer Driver For Windows 3.1

Error message

Possible cause

Recovery

ASPI does not support this

mode!!

ASPI is not initialized!!

SCSI board and its
driver are not installed
correctly.

Correctly install the
SCSI board and its
driver. (Refer to the
manual of the SCSI
board.)

For any other trouble
related to SCSI, refer to
the SCSI section of
Care and Maintenance
(0 P.134).

Block 16 table open error:
Table file not open!

1/16 compression table
is not found.

Reinstall the KX-P8410
software.

KX-P8410 is already used
by other devices.

The printer is being
used by another
device.

® Reprint later when
the printer is free
from other jobs.

® Turn off the printer
and the computer,
then turn them on
again.

KX-P8410 is not detected.
Selected port is LPT.
Please check LPT cable,
Power ON or Printer
condition.

The printer connected
with the parallel cable
is not recognized.

Check the cable
connection of the
printer or turn on the
printer.

KX-P8410 is not detected.
Selected port is SCSI.
Please check SCSI cable,
Power ON or Printer
condition

KX-P8410 is not
recognized as a SCSI
device.

Check the cable
connection of the
system or turn on the
printer.

KX-P8410 or Printer Driver

is in error. Abort printing.

An illegal error has
occurred.

® Confirm the SCSI
board is correctly
installed in the
computer or cable is
correctly connected.

® Turn off the
computer, then turn it
on again.

LPT Port or KX-P8410 is
busy.

The printer is printing.

® Reprint later when
the printer is free
from other jobs.

Memory is allocated Above

16MB. If your SCSI
controller is connected in
an ISA slot, Printing may
not print correctly!!

The transfer data area
for printing has
allocated more than
16MB.

Close all applications
and turn off the
computer, then turn it
on again.

Resource DLL file is not
found.

The necessary file for
printing is not found.

Reinstall the KX-P8410
software.
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Error message

Possible cause

Recovery

No ASPI managers were
found!!

One or more ASPI for DOS
managers are loaded which
do not support ASPI for
WIN16!

SCSI board and its
driver are not installed
correctly.

Correctly install the
SCSI board and its
driver. (Refer to the
manual of the SCSI
board.)

For any other trouble
related to SCSI, refer to
the SCSI section of
Care and Maintenance
(0 P.134).

Printing aborted for
occurred SCSI error.

An illegal error has
occurred.

® Confirm the SCSI
board is correctly
installed in the
computer or cable is
correctly connected.

® Turn off the
computer, then turn it
on again.

SCSI Error!! Time Out
occurred.

The printer is not
responding.

Turn off the printer and

the computer, then turn
them on again. Print the
document again.

The printer does not print
correctly (not an error
message).

The computer is not
properly communicating
with the printer.

Follow the procedure

below and disable the bi-

directional interface.

1. Double-click Status
display setup icon in
KX-P8410 Utilities
program group.

2. Click Device tab.

3. Click off Monitor

Printer check box.

4. Click OK.

The Status Display
function becomes
ineffective.

Unable to Allocate Memory

The computer’s
internal memory for
printing is insufficient.

® Close all applications
except for the one
which controls the
printer, then print
again.

® Turn off the
computer, then turn it
on again.

Unable to Free Memory!!

Something happened to
the memory environment
of Windows.

Re-boot Windows.

141



142

Care and Maintenance

Error message

Possible cause

Recovery

Check sum error!!

File ID not match!!

Resource DLL file is not

found.

Table file open error!!

Table file read error!!

* DLL function Error

* DLL not found

The necessary file for
printing is not found.

Reinstall the KX-P8410
software.

m Some application settings may take priority over the printer driver settings.
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Printer Driver For Windows 95

Error message

Possible cause

Recovery

ASPI Manager is not found.
Install ASPI for Windows.
(e.g. install wnaspi32.dll to
your windows (system
directory.)

SCSI board and its
driver are not installed
correctly.

Correctly install SCSI
board and its driver.
(Refer to the manual of
the SCSI board.)

wnaspi32.dll will be
installed or replaced
with a new version.

Can not find Panasonic KX-
P8410. Make sure that
Panasonic KX-P8410 is
connected to your PC by
SCSI, and then retry again.

® Cable connection is
improper or printer is
not ready.

® The terminator
setting is improper.

Perform the following

procedure.

1. Confirm that the
terminator is correctly
set.

2. Confirm that the
printer is ready.

3. Confirm that the
printer is correctly
connected with a
SCSI cable.

4. Turn off the
computer, then turn it
on again.

Can not initialize ASPI for
Windows. Install newer
version of ASPI for
Windows

The ASPI for Windows
installed on this PC does
not have expected function.
Install newer version of
ASPI for Windows.

The ASPI for Windows
installed on this PC does
not support expected
mode. Install newer version
of ASPI for Windows.

The ASPI manager
installed on this PC does
not support Windows.
Install ASPI for Windows.
[e.g. install wnaspi32.dll to
your windows (system
directory)].

SCSI board and its
driver are not installed
correctly.

Correctly install the
SCSI board and its
driver. (Refer to the
manual of the SCSI
board.)

wnaspi32.dll will be
installed or replaced
with a new version.

For any other trouble
related to SCSI, refer to
the SCSI section of
Care and Maintenance
(0 P.134).
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Error message

Possible cause

Recovery

The printer does not print
correctly (not an error
message).

The computer is not
properly communicating
with the printer.

Follow the procedure below
and disable the bi-
directional interface.

1. Click Start, select
Settings, then click
Printers.

2. Click the Panasonic
KX-P8410 icon.

3. Click the File menu, then
click Properties.

4. Click Details tab and
Spool settings....

5. Click Disable bi-
directional support for
this printer, then click
OK.

The Status Display
function becomes
ineffective.

The Status Display
does not appear when
printing a document.

The Status Display
function is not active

Follow the procedure
below to make the setting
active.

1. Click Start, select
Settings, then click
Printers.

2. Click the Panasonic
KX-P8410 printer icon.

3. Click the File menu,
then click Properties.

4. Click Details tab and
Spool settings....

5. Click Enable bi-
directional support for
this printer, then click
OK.

There was an error
writing to LPT1: for the
printer (Panasonic
KX-P8410):

There was a problem
sending your document
to the printer. Make sure
the printer cable is
connected and the
printer is online. To
continue printing, click
retry. Windows will
automatically retry after
5 seconds

Cable connection is
improper or the printer
is not ready.

Connect the printer
(parallel cable) correctly or
make the printer ready.
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Error Message

Possible Cause

Corrective Action

There was an error

writing to KXP8410GDl:

for the printer
(Panasonic KX-P8410):

The printer is not ready.

Make sure it is turned
on and online. To
continue printing, click
retry. Windows will
automatically retry after
5 seconds

® Cable connection is
improper or the
printer is not ready.

® The terminator
setting is improper.

Perform the following

procedure.

1. Confirm that the
terminator is correctly
set.

2. Confirm that the printer
is ready.

3. Confirm that the printer
is correctly connected
with a SCSI cable.

4. Turn off the computer,
then turn it on again.

Unable to Allocate
Memory!!

The memory for
printing is insufficient.

® Close all applications
except for the one which
controls the printer, then
print it again.

® Turn off the computer,
then turn it on again.
Print the document
again.

Can not load pclradj.dll

Check sum error!!

File ID not match!!

Resource DLL file is not
found.

Table file open error!!

Table file read error!!

The necessary file for
printing is not found.

Reinstall the KX-P8410
software.

145



146

Care and Maintenance

Error message

Possible cause

Recovery

Windows could not write
to the printer spool file.

Make sure your disk has
enough free space and
try again.

Hard disk space is
insufficient.

Increase the hard disk
space.

If it is difficult to increase the
hard disk space or printing
error occurs even after
increasing the hard disk
space, change the spool
data format from EMF to
RAW by performing the
following steps.

However, RTA (Return To
Application: the length of
time between the start of
printing and the return of
control to an application) of
RAW is longer than that of
EMF.

1. Click Start, select
Settings, then click
Printers.

2. Click the Panasonic
KX-P8410 icon.

3. Click the File menu, then
click Properties.

4. Click the Details tab and
Spool settings....

5. Change the Spool data
format to RAW, then
click OK.

m Some application settings may take priority over the printer driver settings.
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Printer Driver For Windows NT 4.0

Error message

Possible cause

Recovery

ASPI Manager is not
found. Install ASPI for
Windows. (e.g. install
wnaspi32.dll to your
system32 directory).

SCSI Board and its
driver are not installed
correctly.

Correctly install SCSI board
and its driver. (Refer to the
instructions manual of the
SCSI board.)

Whnaspi32.dll will be
installed or replaced with a
new version.

Can not initialize ASPI for
Windows. Install newer
version of ASPI for
Windows.

The ASPI for Windows
installed on this PC does
not have expected
function. Install newer
version of ASPI for
Windows.

The ASPI for Windows
installed on this PC does
not support expected
mode. Install newer
version of ASPI for
Windows.

The ASPI for Windows
installed on this PC does
not support Windows.
Install ASPI for Windows.
[e.g.install wnaspi32.dll to
your system32 directory]

SCSI Board and its
driver are not installed
correctly.

Correctly install SCSI board
and its driver. (Refer to the
instructions manual of the
SCSI board.)

Whnaspi32.dll will be
installed or replaced with a
new version.

For any other trouble related
to SCSI, refer to the SCSI
section of Care and
Maintenance ([ P. 134).

Error writing to
KXP8410GDI: for <print job
name>: The printer command
is invalid. Do you wish to
retry or cancel the job?

Separator page has
been set. When SCSI
port is used, Separator
page cannot be used.

Cancel the Separator page
setting.

Error writing to LPT1: for
“Application name”: The
device is not ready. Do
you wish to retry or
cancel the job?

Cable connection is
improper or printer is not
ready.

Connect the printer (parallel
cable) correctly or make the
printer ready.
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Error message

Possible cause

Recovery

Error writing to “Port
name” for “Application
name”: The request could
not be performed
because of an 1/0 device
error. Do you wish to retry
or cancel the job?

® Cable connection is
improper or printer is
not ready.

® The terminator setting
is improper.

Perform the following

procedure.

1. Confirm that the
terminator is correctly set.

2. Confirm that the printer is
ready.

3. Confirm that the printer is
correctly connected with
a SCSI cable.

4. Turn off the computer,
then turn it on again.

System Process-Out of
Virtual Memory

Your system is running
low on virtual memory.
Please close some
applications. You can
then start the System
option in the Control
Panel and choose the
Virtual Memory button to
create an additional
paging file or to increase
the size of your current
paging file.

Your system is running
low on virtual memory.

Increase the virtual memory
by following the procedure
below.

1. Click Start, Settings,

then click Control Panel.

2. Double click the System

icon.

3. Click the Performance
tab.

. Click Change....

5. Increase the value of
Initial Size [MB] and
Maximum Size [MB].

. Click Set.

. Click OK.

. Click Close.

. Click Yes in the System
Settings Change dialog,
then restart your
computer.

N

© 00N

If the same error message
appears after increasing the
virtual memory, repeat the
steps above.
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Status Display

Error message

Possible cause

Recovery

ASPI for Win 16 or 32
could not properly
initialize itself. This may
be caused by a lack of
system resources.

Lack of system
resources, or other
trouble related to
SCSI.

Close some application
and retry. For any other
trouble related to SCSI,
refer to the SCSI section of
Care and Maintenance

(0 P. 134).

Invalid LPT Port.

Unavailable LPT port is
selected when using
Windows 3.1.

Select the other available

LPT port by following the

procedure below.

1. Double click the Main
icon.

2. Double click the Control
Panel icon.

3. Double click the Printers
icon.

4. Click Connect... .

5. Click the other port, then
click OK.

6. Click Close.

Load Library Error!,
File Open Error! or
Install Error! appears
and Status Display does
not appear.

The necessary file is
not installed in the
computer.

Reinstall the KX-P8410
software.

No ASPI managers are
loaded. This typically
occurs when a DOS
ASPI manager is not
resident in memory.

SCSI board is not
correctly set.

Correctly set the SCSI
board in the computer.
(Refer to the manual of the
SCSI board.)

For any other trouble
related to SCSI, refer to
the SCSI section of Care
and Maintenance

(O P.134).

Not Detect.

® The printer was
turned on after
turning on the
computer.

® The terminator
setting is improper.

® SCSI setting or
cable connection is
improper.

Turn off the printer and the

computer, then turn them

on again. If the trouble still

remains, confirm the

following points.

® The terminator is
correctly set.

® The SCSI board is
correctly installed in the
computer.

® The system is correctly
connected with SCSI
cables.

® Each SCSI device has a
different ID Number.
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Error message

Possible cause

Recovery

One or more ASPI for
DOS managers are
loaded which do not
support ASPI for Win16
or 32.

SCSI board is not set
correctly.

Correctly set the SCSI
board in the computer.
(Refer to the manual of the
SCSI board.)

For any other trouble
related to SCSI, refer to
the SCSI section of Care
and Maintenance

(O P.134).

There isn’t available
LPT Port.

Unavailable LPT port is
selected when using
Windows 3.1.

Select an available LPT

port by following the

procedure below.

1. Double click the Main
icon.

2. Double click the Control
Panel icon.

3. Double click the Printers
icon.

4. Click Connect... .

5. Click the other port, then
click OK.

6. Click Close.

This ASPI manager
does not support this
mode of Windows. You
typically see this error
code when running
Windows in Real Mode

SCSI board is not set
correctly.

Restart Windows in
Enhanced mode.

SCSI device can not be
used. Because ASPI dll
file is not exist or
doesn’t match.

SCSI board is not
installed correctly in
the computer and/or it
is not set correctly.

Confirm that the SCSI
board is correctly installed
in the computer and it is
set correctly. (Refer to the
manual of the SCSI
board.)

For any other trouble
related to SCSI, refer to
the SCSI section of Care
and Maintenance

(0O P.134).
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Error message

Possible cause

Recovery

SCSI device is not
responded.

Printer is not
responding.

Click Yes or No on the

message window.

Yes: Printer cannot be
used. Turn off the
printer and the
computer, then turn
them on again.

No: Waits until the printer

responds.

Status Display does not
exist.

KX-P8410 software is
not installed correctly.

Reinstall the KX-P8410
software.

winaspi.dll is not found.

SCSI board is not
correctly set.

Correctly set the SCSI
board in the computer.
(Refer to the instructions
manual of the SCSI
board.) For any other
trouble related to SCSI,
refer to the SCSI section of
Care and Maintenance

(O P.134).
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Status Display Program

The Status Display program alerts the user to any errors. It displays an error
message, identifies the problem area on the printer, and provides information
regarding corrective action.

mFor Windows 3.1 users:

When Windows 3.1 is started, the Panasonic Printer Status icon appears and
stays on the screen. This enables you to display the printer’s status at any
stage during operation.

The Panasonic Printer Status dialog box appears when:
® A SCSI device error is found while using the printer driver.

This dialog box reduces to an icon when:
® The printer recovers from an error situation

If you have selected the “When device error” option in the Start Up box of the

Setup for Status Display dialog box:

® The Panasonic Printer Status icon does not appear when Windows 3.1 is
started

® The Panasonic Printer Status dialog box disappears after recovering from an
error situation

Note:
® The Setup for Status Display dialog box can be displayed by double clicking the
Status display setup icon. In this dialog box you can display the Start Up box by
clicking the Start Up tab.

mFor Windows 95/ Windows NT 4.0 users:

The Panasonic Printer Status dialog box appears when:
® A SCSI device error is found while using the printer driver

This dialog box disappears when:
® The printer recovers from an error situation
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Printer Status Dialog Box

Panasonic Printer Status

Status: Recoveny: ? ®
(1] (12}
tode:
Device: 9
Interface:
Traw:
b erniarny:
e ¢ 299

Resume | Qanlcel | ﬁﬁﬁ

Setup ‘ Abot ‘ Configuration |

© (4] (5] (8]
@ This box shows an error or status message and the corresponding icon.
@ This box lists the mode your printer is in, device name (printer), interface cable
and tray being used, the built-in memory size of the printer and the name of the

print job.

© This button minimizes the Panasonic Printer Status dialog box. Pressing the ESC
key on the keyboard can also minimize it.

O This button displays the Setup for Status Display dialog box, where you can
change different settings.

@ This button displays the version of the Status Display.

@ This button resumes printing after recovering from an error situation.
@ This button cancels the print job which caused an error.

© This button displays the Panasonic Show Configuration dialog box.
© This button displays the previous recovery message.

@ This button displays the initial recovery message.

@ This button displays the next recovery message.

@ This box displays a recovery procedure along with a picture.

@® This button provides you additional help.
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Repacking

It is highly recommended that you keep the original carton and ALL packing

materials. Should you need to transport or ship your printer, please follow these
instructions.

Safety Caution:
® The printer weighs about 47.9 kg {105.5 Ibs.}. It must be handled by two people.

Notes:
® Should you need to send your printer for service, consult your reseller first or
Panasonic.
® Please use the original carton and all of the original packing materials.
® /f you do not have the packing for the imaging unit and the transfer unit: contact
Panasonic for packaging.

® /mproper repacking of the printer may result in a service charge to remove
spilled toner.

® Since the printer uses dry toner, extreme care must be taken when handling.
The printer should be handled in the upright (vertical) position.

Material required:

® Original cartons and packing materials
® Newspaper or drop cloth

® Shipping tape and scissors
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Turn off the printer; remove the power cord and all interface
cables.

Remove the media tray(s) from the printer; remove the media
from the tray(s).

Press down on a media tray’s metal plate. Place the cardboard
packing material into the media tray.
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4 Reinsert the media tray into the printer; use adhesive tape to
secure the tray to the printer.

5 If you have other media trays, repack them for shipping or
storage in their original shipping boxes.

6 @ Open the printer’s front door.

@ Loosen the two thumbscrews by turning them
counterclockwise.

© Turn the lower green lever 180° counterclockwise.

%‘

© Grasping the front green handle, slide the unit out until it
catches.

@ Lift up the green handle on the left. Pull the imaging unit out of
the printer.

Important:
® Do not touch the green surface (the right side) or the black belt (the under side).

Finger prints may affect the print quality.
Safety Caution:

® The imaging unit weighs approximately 6.5 kg {14.3 Ibs.}. Always use the
handles when lifting it.

Green surface

Black belt
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8 Wrap the imaging unit with a protective black plastic sheet.

Caution:
® Do not expose the imaging unit to light for more than 45 seconds to avoid
damage.

9 On the imaging unit, turn the upper lever 90° counterclockwise;
this is necessary to protect the imaging unit during shipment.
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ll © Open the left side door.

@ Using the green handles, slide the paper feeder out.

12 @ Push in on green tabs to unlock the cover.

@ Raise the cover until it catches in the open position.

13 @ Rotate the transfer unit's green handles up.
@ Lift out the transfer unit.
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l Place the transfer unit on newspaper or drop cloth. Rotate the
handles down and wrap the transfer unit with a piece of paper

and adhesive tape.

Note:
® Do not touch or bump the roller: it can damage the roller
1 Install the plastic cover and insert the transfer unit into a plastic
bag and seal the end tightly. Install the transfer unit into the
packaging.

Plastic cover

Plastic bag
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16 Packing the toner cartridges:
@ Open the right side door.

@® Remove a toner cartridge.

S D /'

INIANanEal

Ol

' | ——
\

Caution:
® To avoid possible toner spillage, do not tilt the cartridge.

©® Replace the shipping cover.

O Secure the shipping cover with adhesive tape.

@ Insert each toner cartridge into a plastic bag and seal the end
of the bag tightly.

@ Repeat instructions @ to @ for each toner cartridge.
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1 7 Wipe off any loose toner in and around the printer.

Note:
® /f a toner vacuum is available, it is the best tool for cleaning spilled toner. Do not
use a standard office vacuum, the toner will not be retained by typical vacuum
dust collectors.

18 @ Raise the output tray and secure it to the printer with adhesive
tape.

@ Secure the front door, the multi-purpose tray and the left side
door to the printer with adhesive tape.

If you don’t have a 2nd Cassette Feeder, go to step 20.

1 9 If you have a 2nd Cassette Feeder:

@ Lift the printer up and away from the 2nd Cassette Feeder.

Safety Caution:
® The printer weighs approximately 41.4 kg {91.2 Ibs.} and the 2nd Cassette
Feeder weighs approximately 14.3 kg {31.5 Ibs.}. Observe standard precautions
for lifting heavy objects.

@ Repack the 2nd Cassette Feeder in its original shipping box.
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20 Repack any other accessories in the original shipping box.

21 Repack the printer in the original shipping box. Make sure that
you keep the printer upright and level when moving.
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Printer

Power source
Refer to the nameplate on the rear of the unit.

Temperature

Operating: 10°C to 32.5°C (50°F to 90.5°F)
Best Print Quality: 15°C to 25°C (59°F to 77°F)
Storage: 0°C to 40°C (32°F to 104°F)
Humidity

Operating: 20% to 80% RH

Best Print Quality: 30% to 70% RH

Storage: 10% to 80% RH

Warm-up time
Less than 200 seconds (at 20°C)

Power consumption

850 W Max. (printing with fuser on)

35 W (standby with fuser off)

25 W (Energy Star mode)

Meets Energy Star power conservation requirements.

Mass {Weight} of standard unit with all consumables
(without optional 2nd Cassette Feeder)
47.9 kg {105.5 Ibs.}

Dimensions of standard unit (Without 2nd Cassette Feeder)
Height: 463 mm (18.2")

Depth: 493 mm (19.4")

Width: 510 mm (20.1") [784 mm (30.9") with the output tray]

Noise level
53 dB(A) [Printing mode]
47 dB(A) [Standby mode]

Printing method
Semiconductor Laser

Paper output
Up to 500 sheets [75 g/m? (20 Ibs.)]

Resolution

600 x 600 dpi
1200 x 1200 dpi (additional RAM required)
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Maximum printing speed
The print speeds listed in the following table represent the time the printer produces
multiple prints on various media and resolution (Continuous throughput rate).

Continuous Print Speed (ppm)

Plain Paper Legal Transparency

color | mono | color | mono | color | mono
600 x 600 dpi 3.5 14 1.75 7 1.75 7
1200 x 1200 dpi 1.75 7 0.87 3.5

RAM buffer
Standard 8 MB (expandable to a maximum of 72 MB with optional SIMMSs)

Printing:

Printable without

Total Memory Selectable Print Quality Mode Memory Overflow

3 MB Fast (300 dpi) Letter, A4 *
(Standard) Standard (600 dpi) Letter, A4 *
Fast (300 dpi L A4, Legal
16 MB (Add 8 MB) (300 dp) etter, A4, Lega
Standard (600 dpi) Letter, A4 *
56 MB (Add 48 MB) , _ , Letter, A4 *
High Quality (1200 dpi)
72 MB (Add 64 MB) Letter, A4 Legal

* Documents can be printed on Legal size paper when the print style is set to Color
Graphics ( [0 P. 72, 83) provided the data size of the document is small.

Note:
® More than 32 MB is required on the printer to use “Printer memory usage” in the
printer driver (0 P. 77, 96).

Interface

Standard: Bidirectional Parallel, SCSI-2
Option: 10 baseT, 10 base2
Altitude

Operating: 0 to 2,500 m (8,000 ft.)
Storage: 0to 4,000 m (13,125 ft.)
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Media
m Media Sizes
Medium Size Dimensions
Paper Letter 216 mm x 279 mm (8.5" x 11")
Ad 210 mm x 297 mm (8.3" x 11.7")
Legal 216 mm x 356 mm (8.5" x 14")
Transparency Letter 216 mm x 279 mm (8.5" x 11")
Ad 210 mm x 297 mm (8.3" x 11.7")
Envelope #10 104.9 mm x 241.3 mm (4.13" x 9.5")
Note:

® Please store your paper according to the recommendations of the manufacturer.

m Margins and Print Area

When the image is printed on the media, the image (print area) is a bit smaller than
the media size. You may need to adjust the page margins in the application software
to match the print area.

The following table and illustrations show the page sizes, the largest print areas, and
the margins for the media sizes supported on this printer.

) ) ) Margins
Media Page size Print area -
Top Bottom | Sides
Letter 216 mMm x 279 mm | 208 mm x 269 mm | 5.6 mm | 5.6 mm | 3.6 mm
(8.5" x 11") (8.2" x 10.6") (0.22") | (0.22") | (0.14M)
A4 210 mm x 297 mm | 200 mm x 287 mm | 5.1 mm | 4.7 mm | 4.7 mm
(8.3" x 11.7") (7.9" x 11.3") (0.2M) (0.129") | (0.19M
Legal 216 mmx 356 mm | 208 mMm x 343 mm | 5.8 mm | 5.8 mm | 3.6 mm
9 (8.5" x 14") (8.2" x 13.5") (0.23") | (0.23") | (0.14M
Letter A4 Legal
208 mm (8.2") 200 mm (7.9") 208 mm (8.2")
© o
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m Paper Weight

The printer is designed to work well with most types of paper. However, differences in
paper may have significant effects on the quality of the print or the reliability of paper
handling.

It is strongly recommended that you always test paper before purchasing it to make
sure it provides desirable performance.

, One-sided B&W | 60 to 105 g/m? (16 to 28 Ibs.)
Media tray * o
printing Color | 75to 105 g/m? (20 to 28 Ibs.)
One-sided B&W 75 to 165 g/m2 (20 to 44 |bS)
, printing Color | 75 to 165 g/m? (20 to 44 Ibs.)
Multi-purpose tray
Two-sided B&W | 75to 105 g/m? (20 to 28 Ibs.)
printing Color | 90 to 105 g/m? (24 to 28 Ibs.)

® Recommended paper (for optimum performance):
LETTER/LEGAL : Hammermill LASERPRINT 90 g/m? (24 Ibs.)
Ad : NEUSIEDLER COLOR COPY 90 g/m?

* We do not recommend the use of 105 g/m? (28 Ibs.) paper in areas of high or low
humidity and temperature since paper feed problems may be experienced.

m Types of Paper to Avoid

® Extremely smooth or shiny paper or paper that is highly textured

® | etterhead imprinted with low temperature or thermography. These materials may
transfer onto the fusing roller and cause damage. Any pre-printed paper should
use inks compatible with 200°C (392°F) for 0.1 second.

® Damaged or wrinkled paper, or paper with irregularities such as tabs, staples, etc.

® Multipart forms or carbonless paper

® Paper with a 25% or more cotton and/or fiber content

® |nk jet paper (It may transfer onto the fuser roller and cause damage.)

m Two-Sided Printing

Two-sided printing is possible by using the multi-purpose tray. However, you should
not expect the same print quality and reliability that you get with one-sided printing.
We strongly recommend that you follow the guidelines below.

® Do not load more than 10 sheets in the multi-purpose tray.
® Before loading paper in the multi-purpose tray, adjust it so that the edges are even.
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m Transparencies and Labels

You may also print on transparencies and labels that are made for the printer.
Panasonic has tested and found that the following work satisfactorily.

OHP transparency 3M CG3700
Labels AVERY 5163, AVERY 5164, AVERY 5165
Avery L7163, Avery L7165, Avery L7166, Avery L7167

Avery L7168, Avery L7169

® Re-using transparencies that have been fed through the printer once (for
example, after jams or if the transparency is ejected without being printed) can
reduce the life of the consumables and paper path components.

® When using transparencies, if the print quality is poor, print on the other side.

® With any label stock, the labels must completely cover the backing material.

| YES |

Labels cover the entire backing material.

NO

The backing material is exposed.
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mEnvelopes

It is recommended that you print in black text only and purchase high quality #10 or
larger laser envelopes with diagonal seams, as shown in the diagram below:

—

High quality envelopes have the following characteristics:

® A thin, sharply creased leading edge
® Paper weight of 90 g/m? (24 Ibs.)
® Flat, free of curls, wrinkles, nicks, etc.

Note:
® Wrinkle may occur in some case, even if high quality envelopes are used.

It is not recommended that you use envelopes with any of the following
characteristics (using these may result in paper jams):

® [rregularly shaped envelopes

® Envelopes with curls, wrinkles, nicks, twists, dog-ears or other damage
® Envelopes with side seam construction

® Highly textured envelopes, or with extremely shiny surfaces

® Envelopes that seal by removing a peel-off strip

® Envelopes with more than one flap to be sealed

® Self-adhesive envelopes

® Envelopes that are baggy or not sharply creased

® Embossed envelopes

® Envelopes that have previously been printed on

-

Side seam construction Peel-off strip Multiple flaps

T

T~

£
Twist Curl Bent-edge
—1
—]

%

Wave Dog-ears Self adhesive
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Do not attempt to print on any of the following types of envelopes. These may cause
damage to your printer.

® Envelopes with clasps, snaps or tie strings (see Figure 1)

® Envelopes with transparent windows (see Figure 2)

® Envelopes that will melt, discolor, scorch offset or release hazardous emissions
when exposed to 200°C (392°F) for 0.1 second

® Envelopes that use encapsulated types of adhesive that do not require moistening
but rely on pressure to seal them

4@7

Figure 1 Figure 2

Always test a sample of the envelopes you are thinking of buying. Confirm that the
envelope performs acceptably.

For best printing results

® Avoid printing in high humidity i.e., above 70%.
High humidity may cause the envelope to curl and pick up excess toner.
High humidity may also cause the envelope to seal.

® Avoid printing below 10°C (50°F) with less than 30% relative humidity.
Low temperature with low humidity may cause light printing.

Envelope storage is very important. Store them away from moisture and humid air,

where they can lay flat and their edges won't be bent or damaged. The humidity
should not exceed 70% RH.
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Software

Windows Version

® \Windows 95, Windows 3.1, Windows NT 4.0 (Intel Only)

GDI Printer Driver

Color Management: ICM

Bundled Software

® Panasonic font manager with 96 fonts

System Requirement
CPU:

Operating System:
Memory:

Free disk space
Virtual memory:

Display:

Drive:

More than Pentium or Pentium PRO

(133 MHz or faster CPU is recommended.)

Windows 3.1, Windows 95 or Windows NT 4.0 (Intel Only)
16 MB or more (More than 32 MB is recommended.)

100 MB or more

16 MB or more (More than 32 MB is recommended.) for
Windows 3.1 /95

50 MB or more (More than 100 MB is recommended.) for
Windows NT 4.0.

Video card that display more than 256 colors.

(A video card that can display more than 32,000 colors is
recommended.)

CD-ROM drive
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Bidirectional Parallel Interface

The bidirectional parallel interface is based on the IEEE P1284-C standard.

If your computer has a bidirectional parallel port, the printer driver and printer can

take advantage of faster data transfer.

Specifications

Connector Type

IEEE 1284-C type connector

Cable

Use a shielded cable 2 m (6.6 ft.) or less in length.

Pin configuration

Signal Pin s?:(taup:inn Signal Signal Pin s?jéu[;?n Signal
1 19 Busy 13 31 Data 8
2 20 Select 14 32 ninit
3 21 nAck 15 33 nStrobe
4 22 nFault 16 34 nSelectin
5 23 PError 17 35 nAutoFd
6 24 Data 1 18 g +5V(Host)
7 25 Data 2 36 U +5V(Peripheral)
8 26 Data 3
9 27 Data 4
10 28 Data 5
11 29 Data 6
12 30 Data 7

Parallel Interface connector (printer side)

1

Notes:

o) [T Jlb°
ol i i D D e T e T U N D A
36 19

® “‘Return” denotes the return side wire of a twisted pair cable and is connected to
signal ground.
® Be sure to use only a shielded cable. The printer will not operate properly if any

of the pins is not connected.
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SCSI Interface

The Panasonic SCSI interface is based on fast SCSI-2 ANSI standard.

Specifications

Connector Type | 50-Pin Half Pitch Pin-type Connector

Use a shielded cable for SCSI-2 (FAST SCSI).
Cable The total length of the SCSI chain must not exceed 3 m (9.8 ft.)
to ensure reliable operation.

Pin Configuration

Signal Pin Signal Signal Pin Signal
1 GND 26 -DB(0)
2 GND 27 -DB(1)
3 GND 28 -DB(2)
4 GND 29 -DB(3)
5 GND 30 -DB(4)
6 GND 31 -DB(5)
7 GND 32 -DB(6)
8 GND 33 -DB(7)
9 GND 34 -DB(P)
10 GND 35 GND
11 GND 36 GND
12 (RESERVED) 37 (RESERVED)
13 (OPEN) 38 TERMPWR
14 (RESERVED) 39 (RESERVED)
15 GND 40 GND
16 GND 41 -ATN
17 GND 42 GND
18 GND 43 -BSY
19 GND 44 -ACK
20 GND 45 -RST
21 GND 46 -MSG
22 GND 47 -SEL
23 GND 48 -C/D
24 GND 49 -REQ
25 GND 50 -1/0

SCSI Interface Connector (Printer side)
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Aboutbutton . .................. 71,73, 99, 153
ACinlet......... .. .. . . 18, 34, 36
Add Portbutton ............ ... .. .. ... 88
Add Printer . ....... ... ... 44
Advancedtab .......... ... ... ... ... ... 82
Alternate Drivers . ....... ... . . ... 92
Auto Continue ........................ 62, 63
Auto, tray selection . . ................... 71, 81
B |
Bidirectional Parallel Interface .............. 171
Black ....... ... ... ... ... ... 61, 62, 101
Black Text, printstyle .. ................. 72,83
Blue, ColorBalance ...................... 100
Brightness . ....... ... .. . .. ... . 98
Calibration Offset ...................... 61, 62
CalibrationPage ....................... 56-58
Calibration TestPrint . ............... 61, 63, 64
<«4/CANCEL button . ................. 19, 61, 63
Cautions . ... 8, 10, 12
Cautionlabels ........ ... . ... ... .. ... 10
CD-ROM ... .. . 13, 17
Checkedport ........ ... . .. ... . 88
Cleaning the printer . ..................... 106
Cleaningthesensor ...................... 107
Clearingajam .......... .. ..., 112
Clientcomputer .......... . ... ... 50
Color adjustment . ........................ 98
Colorbalance . ....... ... . ... .. ... . .... 100
Color Calibration ...................... 61, 62
Color calibrationcard . .................. 17,58
Color calibrationpage ................... 56-58
Color CMYK adjustment . . . ................ 101
Color Graphics, printstyle ............... 72,83
Colormanagement . . ...................... 74
Color Photo, printstyle . . ................ 72,83
Configuration Page ................. 61, 62, 64
Connecting

Printer to computer ........... ... . ..... 33
Contents . ... i 6,7
A/CONTINUE button . ... ............ 19, 61, 63
Contrast . ... 98
COpPIES . vt 71
CopyCount ... ... 81
Cyan ..o 61, 62, 101

Data Timeout ......................... 62, 63
Density Adjustment . ........... 75, 85, 102, 103
Detailstab .......... ... ... . . ... . . ... 69
Device Settingstab ............. ... ... . ... 95
Ditheringmode .. ...................... 73, 84
DocumentOptions .. .......... i, 83
End-user license agreement . ................ 4
Energy Star ....... ... ... . ... .. 3,62, 63
ENTER button ..................... 19, 61, 64
Envelopes ......... ... . . .., 168
ERROR indicator .............. ... ...... 20
Errormessages . ..................... 137-151
Evenpages ......... ... . . .. . i 105
Face down, outputorder ................ 70, 85
Face up, outputorder .. ................. 70, 85
Fast, printquality .................. 73, 84,164
Features . ... ... 14
Fontmanager ........................ 54,170
Forusersin UK. ......................... 11
Foryoursafety .......... ... .. ... .. ... .... 8
Form To Tray Assignment .................. 96
Frontdoor.......... ... ... .. ... ..... 18, 21
Fuser ....... .. ... . . ... 18, 63, 111, 116
Gray Scale, density adjustment . ... ... 75, 85, 102
Gray Scale, printstyle .................. 72,83
Green,ColorBalance . .................... 100
High quality, print quality ............ 73, 84,164
Hue . ... . 98
Hyper-Tetra Adjustment . ......... 74, 85, 97-101

Color Adjustment . ..................... 98

ColorBalance ........................ 100

Color CMYK Adjustment . ............... 101
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